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ELD.K12.ELL.MA.1

English language learners communicate
information, ideas and concepts necessary for
academic success in the content area of
Mathematics.

ELD.K12.ELL.MA.1

English language learners communicate
information, ideas and concepts necessary for
academic success in the content area of
Mathematics.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Angles, Triangles, and Polygons > Construct Triangles and Polygons >
Discover > Engage > Hands-On Activity: Picture This!
https://app.discoveryeducation.com/learn/player/480d609d-743e-40a98ea3-0b3ee5d1dbf9
Angles, Triangles, and Polygons > Construct Triangles and Polygons >
Discover > Investigate > Extension: Construct Right Triangles > Draw Your
Own Right Triangles
https://app.discoveryeducation.com/learn/techbook/units/4fcd8ed4-663c47c8-a086-922bae8524e7/concepts/90aae01d-0f30-4db9-afe0ab8c1cb57a85/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/792a681f-a660-471a-bc4c-aac113b6f19b

BENCHMARK CODE

BENCHMARK

ELD.K12.ELL.MA.1

English language learners communicate
information, ideas and concepts necessary for
academic success in the content area of
Mathematics.

ELD.K12.ELL.SI.1

ELD.K12.ELL.SI.1

ELD.K12.ELL.SI.1

LAFS.68.RST.1.3

English language learners communicate for social
and instructional purposes within the school
setting.

English language learners communicate for social
and instructional purposes within the school
setting.

English language learners communicate for social
and instructional purposes within the school
setting.

Follow precisely a multistep procedure when
carrying out experiments, taking measurements,
or performing technical tasks.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Ratios and Proportions > Investigate Ratios and Rates > Discover > Engage >
Ratios in Body Parts
https://app.discoveryeducation.com/learn/techbook/units/BBE6398A-B4A743CE-A653-D849F49123AA/concepts/40A89961-E083-43A0-A4913B9C91B95764
Angles, Triangles, and Polygons > Construct Triangles and Polygons >
Discover > Engage > Hands-On Activity: Picture This!
https://app.discoveryeducation.com/learn/player/480d609d-743e-40a98ea3-0b3ee5d1dbf9
Angles, Triangles, and Polygons > Construct Triangles and Polygons >
Discover > Investigate > Extension: Construct Right Triangles > Draw Your
Own Right Triangles
https://app.discoveryeducation.com/learn/techbook/units/4fcd8ed4-663c47c8-a086-922bae8524e7/concepts/90aae01d-0f30-4db9-afe0ab8c1cb57a85/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/792a681f-a660-471a-bc4c-aac113b6f19b
Ratios and Proportions > Investigate Ratios and Rates > Discover > Engage >
Ratios in Body Parts
https://app.discoveryeducation.com/learn/techbook/units/BBE6398A-B4A743CE-A653-D849F49123AA/concepts/40A89961-E083-43A0-A4913B9C91B95764
Ratios and Proportions > Investigate Ratios and Rates > Discover > Engage >
Ratios in Body Parts
https://app.discoveryeducation.com/learn/techbook/units/BBE6398A-B4A743CE-A653-D849F49123AA/concepts/40A89961-E083-43A0-A4913B9C91B95764

BENCHMARK CODE

BENCHMARK

LAFS.68.RST.1.3

Follow precisely a multistep procedure when
carrying out experiments, taking measurements,
or performing technical tasks.

LAFS.68.RST.1.3

LAFS.68.RST.2.4

LAFS.68.RST.2.4

LAFS.68.RST.2.4

Follow precisely a multistep procedure when
carrying out experiments, taking measurements,
or performing technical tasks.

Determine the meaning of symbols, key terms,
and other domain-specific words and phrases as
they are used in a specific scientific or technical
context relevant to grades 6–8 texts and topics.

Determine the meaning of symbols, key terms,
and other domain-specific words and phrases as
they are used in a specific scientific or technical
context relevant to grades 6–8 texts and topics.

Determine the meaning of symbols, key terms,
and other domain-specific words and phrases as
they are used in a specific scientific or technical
context relevant to grades 6–8 texts and topics.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Ratios and Proportions > Represent Proportions > Discover > Engage > Falling
from a Height
https://app.discoveryeducation.com/learn/techbook/units/BBE6398A-B4A743CE-A653-D849F49123AA/concepts/6B3F0F97-3400-439C-A250FBDB231B1F3F
Populations and Samples > Explore Populations and Samples > Discover >
Investigate > Investigation 4: Using Samples to Make Predictions
https://app.discoveryeducation.com/learn/techbook/units/afa4bf0f-14a746f0-8c35-5511995b991b/concepts/f9cd5971-c64e-4acc-876063756e5337d1/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/1491f7c6-d9a5-45c7-958f-0bc722819349
Ratios and Proportions > Represent Proportions > Discover > Engage > Falling
from a Height
https://app.discoveryeducation.com/learn/techbook/units/BBE6398A-B4A743CE-A653-D849F49123AA/concepts/6B3F0F97-3400-439C-A250FBDB231B1F3F
Populations and Samples > Explore Populations and Samples > Apply > Apply
1: How Can You Get the Survey Results You Want?
https://app.discoveryeducation.com/learn/techbook/units/afa4bf0f-14a746f0-8c35-5511995b991b/concepts/f9cd5971-c64e-4acc-876063756e5337d1/tabs/6dc41756-43ff-4f63-bd113148dd938983/pages/910C6BAE-ED3D-452A-B4DD-D57B8175FAFF
Populations and Samples > Explore Populations and Samples > Apply > Apply
3: How Did Researchers Count the Gorilla Population in Congo?
https://app.discoveryeducation.com/learn/techbook/units/afa4bf0f-14a746f0-8c35-5511995b991b/concepts/f9cd5971-c64e-4acc-876063756e5337d1/tabs/6dc41756-43ff-4f63-bd113148dd938983/pages/a34af98f-ef4f-487d-b16c-4b73652cb7ec

BENCHMARK CODE

BENCHMARK

LAFS.68.RST.3.7

Integrate quantitative or technical information
expressed in words in a text with a version of that
information expressed visually (e.g., in a
flowchart, diagram, model, graph, or table).

LAFS.68.RST.3.7

LAFS.68.RST.3.7

LAFS.68.WHST.1.1.a

LAFS.68.WHST.1.1.a

Integrate quantitative or technical information
expressed in words in a text with a version of that
information expressed visually (e.g., in a
flowchart, diagram, model, graph, or table).

Integrate quantitative or technical information
expressed in words in a text with a version of that
information expressed visually (e.g., in a
flowchart, diagram, model, graph, or table).

a. Introduce claim(s) about a topic or issue,
acknowledge and distinguish the claim(s) from
alternate or opposing claims, and organize the
reasons and evidence logically.

a. Introduce claim(s) about a topic or issue,
acknowledge and distinguish the claim(s) from
alternate or opposing claims, and organize the
reasons and evidence logically.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Ratios and Proportions > Represent Proportions > Discover > Engage > Falling
from a Height
https://app.discoveryeducation.com/learn/techbook/units/BBE6398A-B4A743CE-A653-D849F49123AA/concepts/6B3F0F97-3400-439C-A250FBDB231B1F3F
Populations and Samples > Explore Populations and Samples > Discover >
Investigate > Investigation 4: Using Samples to Make Predications
https://app.discoveryeducation.com/learn/techbook/units/afa4bf0f-14a746f0-8c35-5511995b991b/concepts/f9cd5971-c64e-4acc-876063756e5337d1/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/1491f7c6-d9a5-45c7-958f-0bc722819349
Populations and Samples > Explores Populations and Samples > Apply >
Apply 1: How Can You Get the Survey Results You Want?
https://app.discoveryeducation.com/learn/techbook/units/afa4bf0f-14a746f0-8c35-5511995b991b/concepts/f9cd5971-c64e-4acc-876063756e5337d1/tabs/6dc41756-43ff-4f63-bd113148dd938983/pages/910C6BAE-ED3D-452A-B4DD-D57B8175FAFF
Angles, Triangles, and Polygons > Construct Triangles and Polygons >
Discover > Engage > Hands-On Activity: Picture This!
https://app.discoveryeducation.com/learn/player/480d609d-743e-40a98ea3-0b3ee5d1dbf9
Ratios and Proportions > Investigate Ratios and Rates > Discover > Engage >
Ratios in Body Parts
https://app.discoveryeducation.com/learn/techbook/units/BBE6398A-B4A743CE-A653-D849F49123AA/concepts/40A89961-E083-43A0-A4913B9C91B95764

BENCHMARK CODE

BENCHMARK

LAFS.68.WHST.1.1.a

a. Introduce claim(s) about a topic or issue,
acknowledge and distinguish the claim(s) from
alternate or opposing claims, and organize the
reasons and evidence logically.

LAFS.68.WHST.1.1.b

LAFS.68.WHST.1.1.b

LAFS.68.WHST.1.1.b

LAFS.68.WHST.1.1.c

b. Support claim(s) with logical reasoning and
relevant, accurate data and evidence that
demonstrate an understanding of the topic or
text, using credible sources.

b. Support claim(s) with logical reasoning and
relevant, accurate data and evidence that
demonstrate an understanding of the topic or
text, using credible sources.

b. Support claim(s) with logical reasoning and
relevant, accurate data and evidence that
demonstrate an understanding of the topic or
text, using credible sources.

c. Use words, phrases, and clauses to create
cohesion and clarify the relationships among
claim(s), counterclaims, reasons, and evidence.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Ratios and Proportions > Represent Proportions > Discover > Engage > Falling
from a Height
https://app.discoveryeducation.com/learn/techbook/units/BBE6398A-B4A743CE-A653-D849F49123AA/concepts/6B3F0F97-3400-439C-A250FBDB231B1F3F
Angles, Triangles, and Polygons > Construct Triangles and Polygons >
Discover > Engage > Hands-On Activity: Picture This!
https://app.discoveryeducation.com/learn/player/480d609d-743e-40a98ea3-0b3ee5d1dbf9
Ratios and Proportions > Represent Proportions > Discover > Engage > Falling
from a Height
https://app.discoveryeducation.com/learn/techbook/units/BBE6398A-B4A743CE-A653-D849F49123AA/concepts/6B3F0F97-3400-439C-A250FBDB231B1F3F
Populations and Samples > Explore Populations and Samples > Apply > Apply
2: How Can You Estimate How Many Fish Are in a Lake?
https://app.discoveryeducation.com/learn/techbook/units/afa4bf0f-14a746f0-8c35-5511995b991b/concepts/f9cd5971-c64e-4acc-876063756e5337d1/tabs/6dc41756-43ff-4f63-bd113148dd938983/pages/11ddf8cb-c3f4-4deb-87ba-e697a5dee5a5
Angles, Triangles, and Polygons > Construct Triangles and Polygons >
Discover > Engage > Hands-On Activity: Picture This!
https://app.discoveryeducation.com/learn/player/480d609d-743e-40a98ea3-0b3ee5d1dbf9

BENCHMARK CODE

BENCHMARK

LAFS.68.WHST.1.1.c

c. Use words, phrases, and clauses to create
cohesion and clarify the relationships among
claim(s), counterclaims, reasons, and evidence.

LAFS.68.WHST.1.1.c

LAFS.68.WHST.1.1.d

LAFS.68.WHST.1.1.d

LAFS.68.WHST.1.1.d

c. Use words, phrases, and clauses to create
cohesion and clarify the relationships among
claim(s), counterclaims, reasons, and evidence.

d. Establish and maintain a formal style.

d. Establish and maintain a formal style.

d. Establish and maintain a formal style.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Ratios and Proportions > Investigate Ratios and Rates > Discover > Engage >
Ratios in Body Parts
https://app.discoveryeducation.com/learn/techbook/units/BBE6398A-B4A743CE-A653-D849F49123AA/concepts/40A89961-E083-43A0-A4913B9C91B95764
Ratios and Proportions > Represent Proportions > Discover > Engage > Falling
from a Height
https://app.discoveryeducation.com/learn/techbook/units/BBE6398A-B4A743CE-A653-D849F49123AA/concepts/6B3F0F97-3400-439C-A250FBDB231B1F3F
Populations and Samples > Explore Populations and Samples > Discover >
Investigate > Investigation 4: Using Samples to Make Predictions
https://app.discoveryeducation.com/learn/techbook/units/afa4bf0f-14a746f0-8c35-5511995b991b/concepts/f9cd5971-c64e-4acc-876063756e5337d1/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/1491f7c6-d9a5-45c7-958f-0bc722819349
Populations and Samples > Explores Populations and Samples > Apply >
Apply 1: How Can You Get the Survey Results You Want?
https://app.discoveryeducation.com/learn/techbook/units/afa4bf0f-14a746f0-8c35-5511995b991b/concepts/f9cd5971-c64e-4acc-876063756e5337d1/tabs/6dc41756-43ff-4f63-bd113148dd938983/pages/910C6BAE-ED3D-452A-B4DD-D57B8175FAFF
Populations and Samples > Explores Populations and Samples > Apply >
Apply 2: How Can You Estimate How Many Fish Are in a Lake?
https://app.discoveryeducation.com/learn/techbook/units/afa4bf0f-14a746f0-8c35-5511995b991b/concepts/f9cd5971-c64e-4acc-876063756e5337d1/tabs/6dc41756-43ff-4f63-bd113148dd938983/pages/11ddf8cb-c3f4-4deb-87ba-e697a5dee5a5

BENCHMARK CODE

BENCHMARK

LAFS.68.WHST.1.1.e

e. Provide a concluding statement or section that
follows from and supports the argument
presented.

LAFS.68.WHST.1.1.e

LAFS.68.WHST.1.1.e

LAFS.68.WHST.2.4:

e. Provide a concluding statement or section that
follows from and supports the argument
presented.

e. Provide a concluding statement or section that
follows from and supports the argument
presented.

Produce clear and coherent writing in which the
development, organization, and style are
appropriate to task, purpose, and audience.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Populations and Samples > Explore Populations and Samples > Discover >
Investigate > Investigation 4: Using Samples to Make Predications
https://app.discoveryeducation.com/learn/techbook/units/afa4bf0f-14a746f0-8c35-5511995b991b/concepts/f9cd5971-c64e-4acc-876063756e5337d1/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/1491f7c6-d9a5-45c7-958f-0bc722819349
Populations and Samples > Explores Populations and Samples > Apply >
Apply 1: How Can You Get the Survey Results You Want?
https://app.discoveryeducation.com/learn/techbook/units/afa4bf0f-14a746f0-8c35-5511995b991b/concepts/f9cd5971-c64e-4acc-876063756e5337d1/tabs/6dc41756-43ff-4f63-bd113148dd938983/pages/910C6BAE-ED3D-452A-B4DD-D57B8175FAFF
Populations and Samples > Explores Populations and Samples > Apply >
Apply 2: How Can You Estimate How Many Fish Are in a Lake?
https://app.discoveryeducation.com/learn/techbook/units/afa4bf0f-14a746f0-8c35-5511995b991b/concepts/f9cd5971-c64e-4acc-876063756e5337d1/tabs/6dc41756-43ff-4f63-bd113148dd938983/pages/11ddf8cb-c3f4-4deb-87ba-e697a5dee5a5
Angles, Triangles, and Polygons > Construct Triangles and Polygons >
Discover > Engage > Hands-On Activity: Picture This!
https://app.discoveryeducation.com/learn/player/480d609d-743e-40a98ea3-0b3ee5d1dbf9

BENCHMARK CODE

BENCHMARK

LAFS.68.WHST.2.4:

Produce clear and coherent writing in which the
development, organization, and style are
appropriate to task, purpose, and audience.

LAFS.68.WHST.2.4:

LAFS.7.SL.1.1.a

LAFS.7.SL.1.1.a

Produce clear and coherent writing in which the
development, organization, and style are
appropriate to task, purpose, and audience.

Come to discussions prepared, having read or
researched material under study; explicitly draw
on that preparation by referring to evidence on
the topic, text, or issue to probe and reflect on
ideas under discussion.
Come to discussions prepared, having read or
researched material under study; explicitly draw
on that preparation by referring to evidence on
the topic, text, or issue to probe and reflect on
ideas under discussion.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Angles, Triangles, and Polygons > Construct Triangles and Polygons >
Discover > Investigate > Extension: Construct Right Triangles > Draw Your
Own Right Triangles
https://app.discoveryeducation.com/learn/techbook/units/4fcd8ed4-663c47c8-a086-922bae8524e7/concepts/90aae01d-0f30-4db9-afe0ab8c1cb57a85/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/792a681f-a660-471a-bc4c-aac113b6f19b
Ratios and Proportions > Investigate Ratios and Rates > Discover > Engage >
Ratios in Body Parts
https://app.discoveryeducation.com/learn/techbook/units/BBE6398A-B4A743CE-A653-D849F49123AA/concepts/40A89961-E083-43A0-A4913B9C91B95764
Angles, Triangles, and Polygons > Construct Triangles and Polygons >
Discover > Engage > Hands-On Activity: Picture This!
https://app.discoveryeducation.com/learn/player/480d609d-743e-40a98ea3-0b3ee5d1dbf9
Angles, Triangles, and Polygons > Construct Triangles and Polygons >
Discover > Investigate > Extension: Construct Right Triangles > Draw Your
Own Right Triangles
https://app.discoveryeducation.com/learn/techbook/units/4fcd8ed4-663c47c8-a086-922bae8524e7/concepts/90aae01d-0f30-4db9-afe0ab8c1cb57a85/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/792a681f-a660-471a-bc4c-aac113b6f19b

BENCHMARK CODE

BENCHMARK

LAFS.7.SL.1.1.a

Come to discussions prepared, having read or
researched material under study; explicitly draw
on that preparation by referring to evidence on
the topic, text, or issue to probe and reflect on
ideas under discussion.

LAFS.7.SL.1.1.b

LAFS.7.SL.1.1.b

LAFS.7.SL.1.1.b

LAFS.7.SL.1.1.c

Follow rules for collegial discussions, track
progress toward specific goals and deadlines, and
define individual roles as needed.

Follow rules for collegial discussions, track
progress toward specific goals and deadlines, and
define individual roles as needed.

Follow rules for collegial discussions, track
progress toward specific goals and deadlines, and
define individual roles as needed.

Pose questions that elicit elaboration and respond
to others’ questions and comments with relevant
observations and ideas that bring the discussion
back on topic as needed.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Ratios and Proportions > Investigate Ratios and Rates > Discover > Engage >
Ratios in Body Parts
https://app.discoveryeducation.com/learn/techbook/units/BBE6398A-B4A743CE-A653-D849F49123AA/concepts/40A89961-E083-43A0-A4913B9C91B95764
Angles, Triangles, and Polygons > Construct Triangles and Polygons >
Discover > Engage > Hands-On Activity: Picture This!
https://app.discoveryeducation.com/learn/player/480d609d-743e-40a98ea3-0b3ee5d1dbf9
Angles, Triangles, and Polygons > Construct Triangles and Polygons >
Discover > Investigate > Extension: Construct Right Triangles > Draw Your
Own Right Triangles
https://app.discoveryeducation.com/learn/techbook/units/4fcd8ed4-663c47c8-a086-922bae8524e7/concepts/90aae01d-0f30-4db9-afe0ab8c1cb57a85/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/792a681f-a660-471a-bc4c-aac113b6f19b
Ratios and Proportions > Investigate Ratios and Rates > Discover > Engage >
Ratios in Body Parts
https://app.discoveryeducation.com/learn/techbook/units/BBE6398A-B4A743CE-A653-D849F49123AA/concepts/40A89961-E083-43A0-A4913B9C91B95764
Angles, Triangles, and Polygons > Construct Triangles and Polygons >
Discover > Engage > Hands-On Activity: Picture This!
https://app.discoveryeducation.com/learn/player/480d609d-743e-40a98ea3-0b3ee5d1dbf9

BENCHMARK CODE

BENCHMARK

LAFS.7.SL.1.1.c

Pose questions that elicit elaboration and respond
to others’ questions and comments with relevant
observations and ideas that bring the discussion
back on topic as needed.

LAFS.7.SL.1.1.c

LAFS.7.SL.1.1.d

LAFS.7.SL.1.1.d

Pose questions that elicit elaboration and respond
to others’ questions and comments with relevant
observations and ideas that bring the discussion
back on topic as needed.

d. Acknowledge new information expressed by
others and, when warranted, modify their own
views.

d. Acknowledge new information expressed by
others and, when warranted, modify their own
views.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Angles, Triangles, and Polygons > Construct Triangles and Polygons >
Discover > Investigate > Extension: Construct Right Triangles > Draw Your
Own Right Triangles
https://app.discoveryeducation.com/learn/techbook/units/4fcd8ed4-663c47c8-a086-922bae8524e7/concepts/90aae01d-0f30-4db9-afe0ab8c1cb57a85/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/792a681f-a660-471a-bc4c-aac113b6f19b
Ratios and Proportions > Investigate Ratios and Rates > Discover > Engage >
Ratios in Body Parts
https://app.discoveryeducation.com/learn/techbook/units/BBE6398A-B4A743CE-A653-D849F49123AA/concepts/40A89961-E083-43A0-A4913B9C91B95764
Angles, Triangles, and Polygons > Construct Triangles and Polygons >
Discover > Engage > Hands-On Activity: Picture This!
https://app.discoveryeducation.com/learn/player/480d609d-743e-40a98ea3-0b3ee5d1dbf9
Angles, Triangles, and Polygons > Construct Triangles and Polygons >
Discover > Investigate > Extension: Construct Right Triangles > Draw Your
Own Right Triangles
https://app.discoveryeducation.com/learn/techbook/units/4fcd8ed4-663c47c8-a086-922bae8524e7/concepts/90aae01d-0f30-4db9-afe0ab8c1cb57a85/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/792a681f-a660-471a-bc4c-aac113b6f19b

BENCHMARK CODE

BENCHMARK

LAFS.7.SL.1.1.d

d. Acknowledge new information expressed by
others and, when warranted, modify their own
views.

LAFS.7.SL.1.2

LAFS.7.SL.1.2

LAFS.7.SL.1.2

Analyze the main ideas and supporting details
presented in diverse media and formats (e.g.,
visually, quantitatively, orally) and explain how
the ideas clarify a topic, text, or issue under study.

Analyze the main ideas and supporting details
presented in diverse media and formats (e.g.,
visually, quantitatively, orally) and explain how
the ideas clarify a topic, text, or issue under study.

Analyze the main ideas and supporting details
presented in diverse media and formats (e.g.,
visually, quantitatively, orally) and explain how
the ideas clarify a topic, text, or issue under study.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Populations and Samples > Explore Populations and Samples > Discover >
Investigate > Investigation 4: Using Samples to Make Predictions
https://app.discoveryeducation.com/learn/techbook/units/afa4bf0f-14a746f0-8c35-5511995b991b/concepts/f9cd5971-c64e-4acc-876063756e5337d1/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/1491f7c6-d9a5-45c7-958f-0bc722819349
Populations and Samples > Explores Populations and Samples > Apply >
Apply 2: How Can You Estimate How Many Fish Are in a Lake?
https://app.discoveryeducation.com/learn/techbook/units/afa4bf0f-14a746f0-8c35-5511995b991b/concepts/f9cd5971-c64e-4acc-876063756e5337d1/tabs/6dc41756-43ff-4f63-bd113148dd938983/pages/11ddf8cb-c3f4-4deb-87ba-e697a5dee5a5
Populations and Samples > Explores Populations and Samples > Apply >
Apply 3: How Did Researchers Count the Gorilla Population in Congo?
https://app.discoveryeducation.com/learn/techbook/units/afa4bf0f-14a746f0-8c35-5511995b991b/concepts/f9cd5971-c64e-4acc-876063756e5337d1/tabs/6dc41756-43ff-4f63-bd113148dd938983/pages/a34af98f-ef4f-487d-b16c-4b73652cb7ec
Populations and Samples > Compare Populations and Samples > Discover >
Engage > Prepared to Win > Graphing Calculator Exploration
https://app.discoveryeducation.com/learn/techbook/units/afa4bf0f-14a746f0-8c35-5511995b991b/concepts/27b8ce5e-a67f-44a8-90bb8fe47882aa97/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/f8f2b6c7-1ae5-4d27-8e13-603fa7ac1c28

BENCHMARK CODE

BENCHMARK

LAFS.7.SL.1.3

Delineate a speaker’s argument and specific
claims, evaluating the soundness of the reasoning
and the relevance and sufficiency of the evidence.

LAFS.7.SL.1.3

LAFS.7.SL.1.3

LAFS.7.SL.2.4

Delineate a speaker’s argument and specific
claims, evaluating the soundness of the reasoning
and the relevance and sufficiency of the evidence.

Delineate a speaker’s argument and specific
claims, evaluating the soundness of the reasoning
and the relevance and sufficiency of the evidence.

Present claims and findings, emphasizing salient
points in a focused, coherent manner with
pertinent descriptions, facts, details, and
examples; use appropriate eye contact, adequate
volume, and clear pronunciation.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Angles, Triangles, and Polygons > Construct Triangles and Polygons >
Discover > Engage > Hands-On Activity: Picture This!
https://app.discoveryeducation.com/learn/player/480d609d-743e-40a98ea3-0b3ee5d1dbf9
Populations and Samples > Explores Populations and Samples > Apply >
Apply 2: How Can You Estimate How Many Fish Are in a Lake?
https://app.discoveryeducation.com/learn/techbook/units/afa4bf0f-14a746f0-8c35-5511995b991b/concepts/f9cd5971-c64e-4acc-876063756e5337d1/tabs/6dc41756-43ff-4f63-bd113148dd938983/pages/11ddf8cb-c3f4-4deb-87ba-e697a5dee5a5
Populations and Samples > Explores Populations and Samples > Apply >
Apply 3: How Did Researchers Count the Gorilla Population in Congo?
https://app.discoveryeducation.com/learn/techbook/units/afa4bf0f-14a746f0-8c35-5511995b991b/concepts/f9cd5971-c64e-4acc-876063756e5337d1/tabs/6dc41756-43ff-4f63-bd113148dd938983/pages/a34af98f-ef4f-487d-b16c-4b73652cb7ec
Angles, Triangles, and Polygons > Construct Triangles and Polygons >
Discover > Investigate > Extension: Construct Right Triangles > Draw Your
Own Right Triangles
https://app.discoveryeducation.com/learn/techbook/units/4fcd8ed4-663c47c8-a086-922bae8524e7/concepts/90aae01d-0f30-4db9-afe0ab8c1cb57a85/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/792a681f-a660-471a-bc4c-aac113b6f19b

BENCHMARK CODE

BENCHMARK

LAFS.7.SL.2.4

Present claims and findings, emphasizing salient
points in a focused, coherent manner with
pertinent descriptions, facts, details, and
examples; use appropriate eye contact, adequate
volume, and clear pronunciation.

LAFS.7.SL.2.4

MAFS.7.EE.2.3

MAFS.7.EE.2.3

Present claims and findings, emphasizing salient
points in a focused, coherent manner with
pertinent descriptions, facts, details, and
examples; use appropriate eye contact, adequate
volume, and clear pronunciation.
Solve multi-step real-life and mathematical
problems posed with positive and negative
rational numbers in any form (whole numbers,
fractions, and decimals), using tools strategically.
Apply properties of operations to calculate with
numbers in any form; convert between forms as
appropriate; and assess the reasonableness of
answers using mental computation and
estimation strategies.
Solve multi-step real-life and mathematical
problems posed with positive and negative
rational numbers in any form (whole numbers,
fractions, and decimals), using tools strategically.
Apply properties of operations to calculate with
numbers in any form; convert between forms as
appropriate; and assess the reasonableness of
answers using mental computation and
estimation strategies.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Populations and Samples > Explores Populations and Samples > Apply >
Apply 1: How Can You Get the Survey Results You Want?
https://app.discoveryeducation.com/learn/techbook/units/afa4bf0f-14a746f0-8c35-5511995b991b/concepts/f9cd5971-c64e-4acc-876063756e5337d1/tabs/6dc41756-43ff-4f63-bd113148dd938983/pages/910C6BAE-ED3D-452A-B4DD-D57B8175FAFF
Populations and Samples > Explores Populations and Samples > Apply >
Apply 2: How Can You Estimate How Many Fish Are in a Lake?
https://app.discoveryeducation.com/learn/techbook/units/afa4bf0f-14a746f0-8c35-5511995b991b/concepts/f9cd5971-c64e-4acc-876063756e5337d1/tabs/6dc41756-43ff-4f63-bd113148dd938983/pages/11ddf8cb-c3f4-4deb-87ba-e697a5dee5a5
Equivalent Expressions > Analyze Algebraic Expressions > Discover >
Investigate > Investigation 2: Evaluating Algebraic Expressions > Hands-On
Activity: Chicken Dippers
https://app.discoveryeducation.com/learn/techbook/units/a7aef4db-08574c8c-81a8-5c2b8c0bc0fe/concepts/7e82d58f-8ff2-4b73-a1bd2d8ef70b626f/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/8ef5ebff-f8b8-4d6e-9da6-31967fd80129
Equivalent Expressions > Combine Algebraic Expressions > Discover >
Investigate > Investigation 2: Factoring Expressions > Interactive: Your First
Loot Haul!
https://app.discoveryeducation.com/learn/techbook/units/a7aef4db-08574c8c-81a8-5c2b8c0bc0fe/concepts/c54efd2e-3957-425b-85ce32fb7534a010/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/36d4c361-e02e-466a-9460-38b1a28c5b0a

BENCHMARK CODE

BENCHMARK

MAFS.7.EE.2.3

Solve multi-step real-life and mathematical
problems posed with positive and negative
rational numbers in any form (whole numbers,
fractions, and decimals), using tools strategically.
Apply properties of operations to calculate with
numbers in any form; convert between forms as
appropriate; and assess the reasonableness of
answers using mental computation and
estimation strategies.
Solve word problems leading to equations of the
form px + q = r and p(x + q) = r, where p, q, and r
are specific rational numbers. Solve equations of
these forms fluently. Compare an algebraic
solution to an arithmetic solution, identifying the
sequence of the operations used in each
approach.
Solve word problems leading to equations of the
form px + q = r and p(x + q) = r, where p, q, and r
are specific rational numbers. Solve equations of
these forms fluently. Compare an algebraic
solution to an arithmetic solution, identifying the
sequence of the operations used in each
approach.
Solve word problems leading to equations of the
form px + q = r and p(x + q) = r, where p, q, and r
are specific rational numbers. Solve equations of
these forms fluently. Compare an algebraic
solution to an arithmetic solution, identifying the
sequence of the operations used in each
approach.

MAFS.7.EE.2.4.a

MAFS.7.EE.2.4.a

MAFS.7.EE.2.4.a

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Equations and Inequalities > Solve Algebraic Inequalities > Discover >
Investigate > Investigation 2: Solving Inequalities
https://app.discoveryeducation.com/learn/techbook/units/8eaffca7-e68345b2-b2ec-1f0a6391cfe2/concepts/fed583a1-b78b-42bb-bb113a7a7a650783/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/04dfad1d-d68f-43d1-9624-2e6db73faed0
Equations and Inequalities > Solve Algebraic Equations > Discover > Engage >
Field Trips
https://app.discoveryeducation.com/learn/techbook/units/8EAFFCA7-E68345B2-B2EC-1F0A6391CFE2/concepts/07F850D8-8F51-4A80-9898F2414120EA95
Equations and Inequalities > Solve Algebraic Equations > Discover >
Investigate > Investigation 4: Into Thin Air
https://app.discoveryeducation.com/learn/techbook/units/8eaffca7-e68345b2-b2ec-1f0a6391cfe2/concepts/07f850d8-8f51-4a80-9898f2414120ea95/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/a268ff25-2a8a-440d-9576-b9a7f3546c04
Equations and Inequalities > Solve Algebraic Equations > Apply > Apply 1:
Would You Save Money in the Long Run Buying Appliances That Are More
Efficient?
https://app.discoveryeducation.com/learn/techbook/units/8eaffca7-e68345b2-b2ec-1f0a6391cfe2/concepts/07f850d8-8f51-4a80-9898f2414120ea95/tabs/6dc41756-43ff-4f63-bd113148dd938983/pages/b8f652f0-fab4-4fc5-9d18-f8095ddd9b64

BENCHMARK CODE

BENCHMARK

MAFS.7.EE.2.4.b

Solve word problems leading to inequalities of the
form px + q > r or px + q < r, where p, q, and r are
specific rational numbers. Graph the solution set
of the inequality and interpret it in the context of
the problem.

MAFS.7.EE.2.4.b

MAFS.7.EE.2.4.b

MAFS.7.G.1.1

Solve word problems leading to inequalities of the
form px + q > r or px + q < r, where p, q, and r are
specific rational numbers. Graph the solution set
of the inequality and interpret it in the context of
the problem.
Solve word problems leading to inequalities of the
form px + q > r or px + q < r, where p, q, and r are
specific rational numbers. Graph the solution set
of the inequality and interpret it in the context of
the problem.
Solve problems involving scale drawings of
geometric figures, including computing actual
lengths and areas from a scale drawing and
reproducing a scale drawing at a different scale.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Equations and Inequalities > Solve Algebraic Inequalities > Discover >
Investigate > Investigation 1: Modeling Algebraic Inequalities
https://app.discoveryeducation.com/learn/techbook/units/8eaffca7-e68345b2-b2ec-1f0a6391cfe2/concepts/fed583a1-b78b-42bb-bb113a7a7a650783/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/446f1308-5d7a-4d7a-bfb6-2c5e44c59079
Equations and Inequalities > Solve Algebraic Inequalities > Discover >
Investigate > Investigation 1: Modeling Algebraic Inequalities > Check for
Understanding
https://app.discoveryeducation.com/learn/player/3d434863-12c9-4a189aa8-319520edf344
Equations and Inequalities > Solve Algebraic Inequalities > Discover >
Investigate > Investigation 3: Graphing Inequalities
https://app.discoveryeducation.com/learn/techbook/units/8eaffca7-e68345b2-b2ec-1f0a6391cfe2/concepts/fed583a1-b78b-42bb-bb113a7a7a650783/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/8980cefa-6b7b-4d45-83d6-d47bc8a3a1e0
Proportional Reasoning and Scale > Design Scale Models > Discover >
Investigate > Investigation 1: Building to Scale
https://app.discoveryeducation.com/learn/techbook/units/772bd3f8-33b24edc-b1c7-c4c4601927ab/concepts/d5bdd478-1203-4a6f-bbdbac76efa79b54/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/edb58816-f11c-4a12-84dc-d88a48463267

BENCHMARK CODE

BENCHMARK

MAFS.7.G.1.1

Solve problems involving scale drawings of
geometric figures, including computing actual
lengths and areas from a scale drawing and
reproducing a scale drawing at a different scale.

MAFS.7.G.1.1

MAFS.7.G.1.2

MAFS.7.G.1.2

Solve problems involving scale drawings of
geometric figures, including computing actual
lengths and areas from a scale drawing and
reproducing a scale drawing at a different scale.

Draw (freehand, with ruler and protractor, and
with technology) geometric shapes with given
conditions. Focus on constructing triangles from
three measures of angles or sides, noticing when
the conditions determine a unique triangle, more
than one triangle, or no triangle.
Draw (freehand, with ruler and protractor, and
with technology) geometric shapes with given
conditions. Focus on constructing triangles from
three measures of angles or sides, noticing when
the conditions determine a unique triangle, more
than one triangle, or no triangle.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Proportional Reasoning and Scale > Design Scale Models > Discover >
Investigate > Investigation 2: Plan Your Vacation
https://app.discoveryeducation.com/learn/techbook/units/772bd3f8-33b24edc-b1c7-c4c4601927ab/concepts/d5bdd478-1203-4a6f-bbdbac76efa79b54/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/d8bff43e-e8f8-4c82-8052-cd1506118dcc
Proportional Reasoning and Scale > Design Scale Models > Discover >
Investigate > Investigation 3: Find the Mistake
https://app.discoveryeducation.com/learn/techbook/units/772bd3f8-33b24edc-b1c7-c4c4601927ab/concepts/d5bdd478-1203-4a6f-bbdbac76efa79b54/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/99f5ccd4-42cb-451d-a2c5-cbd4f67380d2
Angles, Triangles, and Polygons > Construct Triangles and Polygons >
Discover > Investigate > Investigation 2: Copy This!
https://app.discoveryeducation.com/learn/techbook/units/4fcd8ed4-663c47c8-a086-922bae8524e7/concepts/90aae01d-0f30-4db9-afe0ab8c1cb57a85/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/e246f1ac-fb08-40ea-946c-c4b585fb9115
Angles, Triangles, and Polygons > Construct Triangles and Polygons >
Discover > Investigate > Investigation 3: Construct Right Triangles > Draw
Your Own Right Triangles
https://app.discoveryeducation.com/learn/techbook/units/4fcd8ed4-663c47c8-a086-922bae8524e7/concepts/90aae01d-0f30-4db9-afe0ab8c1cb57a85/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/792a681f-a660-471a-bc4c-aac113b6f19b

BENCHMARK CODE

BENCHMARK

MAFS.7.G.1.2

Draw (freehand, with ruler and protractor, and
with technology) geometric shapes with given
conditions. Focus on constructing triangles from
three measures of angles or sides, noticing when
the conditions determine a unique triangle, more
than one triangle, or no triangle.

MAFS.7.G.1.3

MAFS.7.G.1.3

MAFS.7.G.1.3

Describe the two-dimensional figures that result
from slicing three-dimensional figures, as in plane
sections of right rectangular prisms and right
rectangular pyramids.

Describe the two-dimensional figures that result
from slicing three-dimensional figures, as in plane
sections of right rectangular prisms and right
rectangular pyramids.

Describe the two-dimensional figures that result
from slicing three-dimensional figures, as in plane
sections of right rectangular prisms and right
rectangular pyramids.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Angles, Triangles, and Polygons > Construct Triangles > Discover >
Investigate > Investigation 1: What's the Long and Short of It?
https://app.discoveryeducation.com/learn/techbook/units/4fcd8ed4-663c47c8-a086-922bae8524e7/concepts/90aae01d-0f30-4db9-afe0ab8c1cb57a85/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/04315a10-a9fb-41aa-8645-23a2e00b8700
Solid Figures > Explore Three-Dimensional Shapes > Discover > Engage > 3D
to 2D > Hands-On Activity: Visualize the Figure
https://app.discoveryeducation.com/learn/player/1e3668fb-bbc6-449aaf25-3c0e9e6f0004
Solid Figures > Explore Three-Dimensional Shapes > Discover > Investigate >
Investigation 1: Cross-Sectional Collages > Interactive: Prism and Pyramid
Slicer
https://app.discoveryeducation.com/learn/techbook/units/fc000283-5e144b14-80f2-0e334586a0db/concepts/aa206339-c3fb-43a8-8a0405eb3fd652ce/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/4d581a9c-2ea7-4622-b4c7-36ffe7b1dfa0
Solid Figures > Explore Three-Dimensional Shapes > Discover > Investigate >
Investigation 1: Cross-Sectional Collages > Check for Understanding
https://app.discoveryeducation.com/learn/player/f67c0f31-6e5f-4b56-8c92e8ded8bd7ba1

BENCHMARK CODE

BENCHMARK

MAFS.7.G.2.4

Know the formulas for the area and
circumference of a circle and use them to solve
problems; give an informal derivation of the
relationship between the circumference and area
of a circle.

MAFS.7.G.2.4

MAFS.7.G.2.4

MAFS.7.G.2.5

MAFS.7.G.2.5

Know the formulas for the area and
circumference of a circle and use them to solve
problems; give an informal derivation of the
relationship between the circumference and area
of a circle.
Know the formulas for the area and
circumference of a circle and use them to solve
problems; give an informal derivation of the
relationship between the circumference and area
of a circle.
Use facts about supplementary, complementary,
vertical, and adjacent angles in a multi-step
problem to write and solve simple equations for
an unknown angle in a figure.

Use facts about supplementary, complementary,
vertical, and adjacent angles in a multi-step
problem to write and solve simple equations for
an unknown angle in a figure.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Circles > Investigate Circles > Discover > Investigate > Investigation 1: The
Mystery of Circles
https://app.discoveryeducation.com/learn/techbook/units/56cff4d8-19be47b0-a537-1a750a637cd5/concepts/637d0741-f072-4e47-92edc971816af755/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/6b107ae0-c24b-4a38-a2a1-1bfa13f9a8b2
Circles > Investigate Circles > Discover > Investigate > Investigation 2:
Formulas for Circumference
https://app.discoveryeducation.com/learn/techbook/units/56cff4d8-19be47b0-a537-1a750a637cd5/concepts/637d0741-f072-4e47-92edc971816af755/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/3f251454-1135-4f0b-ba1b-18be24812015
Circles > Investigate Circles > Discover > Investigate > Investigation 3:
Determine the Area of a Circle
https://app.discoveryeducation.com/learn/techbook/units/56cff4d8-19be47b0-a537-1a750a637cd5/concepts/637d0741-f072-4e47-92edc971816af755/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/f7a06cea-90b3-4dac-b5e5-2c32b6ce4e87
Angles, Triangles, and Polygons > Understand Angle Relationships > Discover
> Engage > What Angle Do You Need? > Hands-On Activity: What's Your
Angle?
https://app.discoveryeducation.com/learn/player/053c588a-13c1-43a8b757-212766424152
Angles, Triangles, and Polygons > Understand Angle Relationships > Discover
> Investigate > Investigation 3: Follow the Path > Check for Understanding
https://app.discoveryeducation.com/learn/player/dc37e887-c4d5-4c4dbae1-72e417d0548d

BENCHMARK CODE

BENCHMARK

MAFS.7.G.2.5

Use facts about supplementary, complementary,
vertical, and adjacent angles in a multi-step
problem to write and solve simple equations for
an unknown angle in a figure.

MAFS.7.G.2.6

MAFS.7.G.2.6

MAFS.7.G.2.6

Solve real-world and mathematical problems
involving area, volume and surface area of twoand three-dimensional objects composed of
triangles, quadrilaterals, polygons, cubes, and
right prisms.
Solve real-world and mathematical problems
involving area, volume and surface area of twoand three-dimensional objects composed of
triangles, quadrilaterals, polygons, cubes, and
right prisms.
Solve real-world and mathematical problems
involving area, volume and surface area of twoand three-dimensional objects composed of
triangles, quadrilaterals, polygons, cubes, and
right prisms.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Angles, Triangles, and Polygons > Understand Angle Relationships > Discover
> Investigate > Investigation 2: Angle Explorer > Interactive: Angle Explorer
https://app.discoveryeducation.com/learn/techbook/units/4fcd8ed4-663c47c8-a086-922bae8524e7/concepts/8a0970d3-2435-4883-94dd5da5b13dee32/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/bb3c88f0-6cfa-4b88-a4c1-6ab8e4551498
Solid Figures > Explore Three-Dimensional Shapes > Discover > Investigate >
Investigation 2: Surface Area of Prisms
https://app.discoveryeducation.com/learn/techbook/units/fc000283-5e144b14-80f2-0e334586a0db/concepts/aa206339-c3fb-43a8-8a0405eb3fd652ce/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/af10b1b6-001b-4847-87f3-eab84f7d1841
Solid Figures > Explore Three-Dimensional Shapes > Discover > Investigate >
Investigation 3: Surface Area of Pyramids
https://app.discoveryeducation.com/learn/techbook/units/fc000283-5e144b14-80f2-0e334586a0db/concepts/aa206339-c3fb-43a8-8a0405eb3fd652ce/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/9aa3a0ac-ecd9-4a37-93a3-e6a6cf99b2f0
Solid Figures > Explore Three-Dimensional Shapes > Discover > Investigate >
Investigation 6: Surface Area and Volume of Composite Figures
https://app.discoveryeducation.com/learn/techbook/units/fc000283-5e144b14-80f2-0e334586a0db/concepts/aa206339-c3fb-43a8-8a0405eb3fd652ce/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/3a760b30-1d55-4bdf-a118-2e44bf81faca

BENCHMARK CODE

BENCHMARK

MAFS.7.SP.1.1

Understand that statistics can be used to gain
information about a population by examining a
sample of the population; generalizations about a
population from a sample are valid only if the
sample is representative of that population.
Understand that random sampling tends to
produce representative samples and support valid
inferences.
Understand that statistics can be used to gain
information about a population by examining a
sample of the population; generalizations about a
population from a sample are valid only if the
sample is representative of that population.
Understand that random sampling tends to
produce representative samples and support valid
inferences.
Understand that statistics can be used to gain
information about a population by examining a
sample of the population; generalizations about a
population from a sample are valid only if the
sample is representative of that population.
Understand that random sampling tends to
produce representative samples and support valid
inferences.
Use data from a random sample to draw
inferences about a population with an unknown
characteristic of interest. Generate multiple
samples (or simulated samples) of the same size
to gauge the variation in estimates or predictions.

MAFS.7.SP.1.1

MAFS.7.SP.1.1

MAFS.7.SP.1.2

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Populations and Samples > Explore Populations and Samples > Discover >
Engage > Where Do Statistics Come From?
https://app.discoveryeducation.com/learn/techbook/units/AFA4BF0F-14A746F0-8C35-5511995B991B/concepts/F9CD5971-C64E-4ACC-876063756E5337D1
Populations and Samples > Explore Populations and Samples > Discover >
Investigate > Investigation 1: How Does a Sample Compare to a Population?
https://app.discoveryeducation.com/learn/techbook/units/afa4bf0f-14a746f0-8c35-5511995b991b/concepts/f9cd5971-c64e-4acc-876063756e5337d1/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/c71f73c8-d007-4a4f-81dc-b9c847014300
Populations and Samples > Explore Populations and Samples > Discover >
Investigate > Investigation 1: How Does a Sample Compare to a Population?
> Check for Understanding
https://app.discoveryeducation.com/learn/player/c95db794-90bc-40cc966a-80c90f34cdc6
Populations and Samples > Explore Populations and Samples > Discover >
Investigate > Investigation 1: How Does a Sample Compare to a Population?
https://app.discoveryeducation.com/learn/techbook/units/afa4bf0f-14a746f0-8c35-5511995b991b/concepts/f9cd5971-c64e-4acc-876063756e5337d1/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/c71f73c8-d007-4a4f-81dc-b9c847014300

BENCHMARK CODE

BENCHMARK

MAFS.7.SP.1.2

Use data from a random sample to draw
inferences about a population with an unknown
characteristic of interest. Generate multiple
samples (or simulated samples) of the same size
to gauge the variation in estimates or predictions.

MAFS.7.SP.1.2

MAFS.7.SP.2.3

MAFS.7.SP.2.3

MAFS.7.SP.2.3

Use data from a random sample to draw
inferences about a population with an unknown
characteristic of interest. Generate multiple
samples (or simulated samples) of the same size
to gauge the variation in estimates or predictions.
Informally assess the degree of visual overlap of
two numerical data distributions with similar
variabilities, measuring the difference between
the centers by expressing it as a multiple of a
measure of variability.
Informally assess the degree of visual overlap of
two numerical data distributions with similar
variabilities, measuring the difference between
the centers by expressing it as a multiple of a
measure of variability.
Informally assess the degree of visual overlap of
two numerical data distributions with similar
variabilities, measuring the difference between
the centers by expressing it as a multiple of a
measure of variability.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Populations and Samples > Explore Populations and Samples > Discover >
Investigate > Investigation 4: Using Samples to Make Predications
https://app.discoveryeducation.com/learn/techbook/units/afa4bf0f-14a746f0-8c35-5511995b991b/concepts/f9cd5971-c64e-4acc-876063756e5337d1/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/1491f7c6-d9a5-45c7-958f-0bc722819349
Populations and Samples > Explore Populations and Samples > Discover >
Investigate > Investigation 4: Using Samples to Make Predictions > Check for
Understanding
https://app.discoveryeducation.com/learn/player/fd562969-ca50-4447984d-28ceff1e0060
Populations and Samples > Compare Populations and Samples > Discover >
Investigate > Investigation 2: Who Will Get Picked > Check for Understanding
https://app.discoveryeducation.com/learn/player/8f00e46c-0eea-4d1d8d14-b411fe1a1253
Populations and Samples > Compare Populations and Samples > Discover >
Investigate > Investigation 3: Comparing Populations
https://app.discoveryeducation.com/learn/techbook/units/afa4bf0f-14a746f0-8c35-5511995b991b/concepts/27b8ce5e-a67f-44a8-90bb8fe47882aa97/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/126cef7d-5ec3-4315-aa9c-f7d9df57f8b0
Populations and Samples > Compare Populations and Samples > Discover >
Investigate > Investigation 4: Comparing Stimuli
https://app.discoveryeducation.com/learn/techbook/units/afa4bf0f-14a746f0-8c35-5511995b991b/concepts/27b8ce5e-a67f-44a8-90bb8fe47882aa97/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/a7ef211b-cc5d-4e7f-a1ce-12c74eb1eef3

BENCHMARK CODE

BENCHMARK

MAFS.7.SP.2.4

Use measures of center and measures of
variability for numerical data from random
samples to draw informal comparative inferences
about two populations.

MAFS.7.SP.2.4

MAFS.7.SP.2.4

MAFS.7.SP.3.5

Use measures of center and measures of
variability for numerical data from random
samples to draw informal comparative inferences
about two populations.

Use measures of center and measures of
variability for numerical data from random
samples to draw informal comparative inferences
about two populations.

Understand that the probability of a chance event
is a number between 0 and 1 that expresses the
likelihood of the event occurring. Larger numbers
indicate greater likelihood. A probability near 0
indicates an unlikely event, a probability around
1/2 indicates an event that is neither unlikely nor
likely, and a probability near 1 indicates a likely
event.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Populations and Samples > Compare Populations and Samples > Discover >
Investigate > Investigation 2: Who Will Get Picked > Check for Understanding
https://app.discoveryeducation.com/learn/player/8f00e46c-0eea-4d1d8d14-b411fe1a1253
Populations and Samples > Compare Populations and Samples > Discover >
Investigate > Investigation 3: Comparing Populations
https://app.discoveryeducation.com/learn/techbook/units/afa4bf0f-14a746f0-8c35-5511995b991b/concepts/27b8ce5e-a67f-44a8-90bb8fe47882aa97/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/126cef7d-5ec3-4315-aa9c-f7d9df57f8b0
Populations and Samples > Compare Populations and Samples > Discover >
Investigate > Investigation 4: Comparing Stimuli
https://app.discoveryeducation.com/learn/techbook/units/afa4bf0f-14a746f0-8c35-5511995b991b/concepts/27b8ce5e-a67f-44a8-90bb8fe47882aa97/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/a7ef211b-cc5d-4e7f-a1ce-12c74eb1eef3
Probability of Random Events > Predict Probabilities > Discover > Engage >
Understanding Likelihood
https://app.discoveryeducation.com/learn/techbook/units/3EDDFB92-C8E04776-B831-81045EBD4F9F/concepts/0DE3746C-C0CA-43E6-83DF4ADAF5A99933

BENCHMARK CODE

BENCHMARK

MAFS.7.SP.3.5

Understand that the probability of a chance event
is a number between 0 and 1 that expresses the
likelihood of the event occurring. Larger numbers
indicate greater likelihood. A probability near 0
indicates an unlikely event, a probability around
1/2 indicates an event that is neither unlikely nor
likely, and a probability near 1 indicates a likely
event.
Understand that the probability of a chance event
is a number between 0 and 1 that expresses the
likelihood of the event occurring. Larger numbers
indicate greater likelihood. A probability near 0
indicates an unlikely event, a probability around
1/2 indicates an event that is neither unlikely nor
likely, and a probability near 1 indicates a likely
event.
Approximate the probability of a chance event by
collecting data on the chance process that
produces it and observing its long-run relative
frequency, and predict the approximate relative
frequency given the probability.

MAFS.7.SP.3.5

MAFS.7.SP.3.6

MAFS.7.SP.3.6

Approximate the probability of a chance event by
collecting data on the chance process that
produces it and observing its long-run relative
frequency, and predict the approximate relative
frequency given the probability.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Probability of Random Events > Predict Probabilities > Discover > Investigate
> Investigation 1: How Likely?
https://app.discoveryeducation.com/learn/techbook/units/3eddfb92-c8e04776-b831-81045ebd4f9f/concepts/0de3746c-c0ca-43e6-83df4adaf5a99933/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/030db5d3-4a78-44a5-b3a6-7a9da622d5c9
Probability of Random Events > Predict Probabilities > Practice > Coach
https://app.discoveryeducation.com/core:assessment/coach?practice=69aa
5031-ee9f-4304-ade9-73c1c68f9f2d&conceptGuid=0de3746c-c0ca-43e683df-4adaf5a99933&courseGuid=724c539b-ecff-4729-8f7ad53a5bc71043&unitGuid=3eddfb92-c8e0-4776-b83181045ebd4f9f&teacherMode=true
Probability of Random Events > Model Probabilities > Discover > Engage:Use
Experimental Probability to Make Predictions
https://app.discoveryeducation.com/learn/techbook/units/3EDDFB92-C8E04776-B831-81045EBD4F9F/concepts/22A90D5E-04E1-4316-8D094DA85B1DEA00
Probability of Random Events > Model Probabilities > Discover > Investigate
> Investigation 1: Developing a Probability Model by Observing Frequencies
in Data
https://app.discoveryeducation.com/learn/techbook/units/3eddfb92-c8e04776-b831-81045ebd4f9f/concepts/22a90d5e-04e1-4316-8d094da85b1dea00/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/6fad973f-a1da-4ce1-8563-4f28c22f0c72

BENCHMARK CODE

BENCHMARK

MAFS.7.SP.3.6

Approximate the probability of a chance event by
collecting data on the chance process that
produces it and observing its long-run relative
frequency, and predict the approximate relative
frequency given the probability.

MAFS.7.SP.3.7.a

MAFS.7.SP.3.7.a

MAFS.7.SP.3.7.a

MAFS.7.SP.3.7.b

Develop a uniform probability model by assigning
equal probability to all outcomes, and use the
model to determine probabilities of events.

Develop a uniform probability model by assigning
equal probability to all outcomes, and use the
model to determine probabilities of events.

Develop a uniform probability model by assigning
equal probability to all outcomes, and use the
model to determine probabilities of events.

Develop a probability model (which may not be
uniform) by observing frequencies in data
generated from a chance process.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Probability of Random Events > Model Probabilities > Discover > Investigate
> Investigation 2: Meteorite Warning > Hands-On Activity: Meteorite Impact
https://app.discoveryeducation.com/learn/techbook/units/3eddfb92-c8e04776-b831-81045ebd4f9f/concepts/22a90d5e-04e1-4316-8d094da85b1dea00/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/067d21a3-77ed-4921-9f9a-23b9508451f1
Probability of Random Events > Model Probabilities > Discover > Engage:Use
Experimental Probability to Make Predictions
https://app.discoveryeducation.com/learn/techbook/units/3EDDFB92-C8E04776-B831-81045EBD4F9F/concepts/22A90D5E-04E1-4316-8D094DA85B1DEA00
Probability of Random Events > Model Probabilities > Discover > Investigate
> Investigation 1: Developing a Probability Model by Observing Frequencies
in Data > Hands-On Activity: Probability Models
https://app.discoveryeducation.com/learn/player/435a4707-2678-48c8b18b-44750301427c
Probability of Random Events > Model Probabilities > Discover > Investigate
> Investigation 2: Meteorite Warning > Hands-On Activity: Meteorite Impact
https://app.discoveryeducation.com/learn/techbook/units/3eddfb92-c8e04776-b831-81045ebd4f9f/concepts/22a90d5e-04e1-4316-8d094da85b1dea00/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/067d21a3-77ed-4921-9f9a-23b9508451f1
Probability of Random Events > Model Probabilities > Discover > Investigate
> Investigation 2: Meteorite Warning > Hands-On Activity: Meteorite Impact
https://app.discoveryeducation.com/learn/techbook/units/3eddfb92-c8e04776-b831-81045ebd4f9f/concepts/22a90d5e-04e1-4316-8d094da85b1dea00/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/067d21a3-77ed-4921-9f9a-23b9508451f1

BENCHMARK CODE

BENCHMARK

MAFS.7.SP.3.7.b

Develop a probability model (which may not be
uniform) by observing frequencies in data
generated from a chance process.

MAFS.7.SP.3.7.b

MAFS.7.SP.3.8.a

MAFS.7.SP.3.8.a

MAFS.7.SP.3.8.a

Develop a probability model (which may not be
uniform) by observing frequencies in data
generated from a chance process.

Understand that, just as with simple events, the
probability of a compound event is the fraction of
outcomes in the sample space for which the
compound event occurs.

Understand that, just as with simple events, the
probability of a compound event is the fraction of
outcomes in the sample space for which the
compound event occurs.

Understand that, just as with simple events, the
probability of a compound event is the fraction of
outcomes in the sample space for which the
compound event occurs.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Probability of Random Events > Model Probabilities > Discover > Investigate
> Investigation 2: Meteorite Warning > Check for Understanding
https://app.discoveryeducation.com/learn/player/77910b7f-e5bd-4af29559-ca8e9ab75b4d
Probability of Random Events > Model Probabilities > Discover > Investigate
> Investigation 3: Sources of Error
https://app.discoveryeducation.com/learn/techbook/units/3eddfb92-c8e04776-b831-81045ebd4f9f/concepts/22a90d5e-04e1-4316-8d094da85b1dea00/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/ac203592-3210-49ca-84b5-c83b25312439
Probability of Multiple Events > Explore Compound Probabilities > Discover >
Engage > Hands-On Activity: Losing your Marbles
https://app.discoveryeducation.com/learn/player/69ae508d-df46-476e9744-2e460b9afd47
Probability of Multiple Events > Explore Compound Probabilities > Discover >
Investigate > Investigation 1: Probability of Independent Events
https://app.discoveryeducation.com/learn/techbook/units/737f33b4-2d184574-8ca6-473b3c8a5458/concepts/da9248db-e46a-4e32-a25193a3e24896fc/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/91aa4dd9-98cd-42ae-9944-86215d8c857a
Probability of Multiple Events > Explore Compound Probabilities > Discover >
Investigate > Investigation 2: Making a Random Playlist
https://app.discoveryeducation.com/learn/techbook/units/737f33b4-2d184574-8ca6-473b3c8a5458/concepts/da9248db-e46a-4e32-a25193a3e24896fc/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/98703019-9576-4c73-b4b9-78f4b2d13ae8

BENCHMARK CODE

BENCHMARK

MAFS.7.SP.3.8.b

Represent sample spaces for compound events
using methods such as organized lists, tables and
tree diagrams. For an event described in everyday
language (e.g., “rolling double sixes”), identify the
outcomes in the sample space which compose the
event.

MAFS.7.SP.3.8.b

MAFS.7.SP.3.8.b

MAFS.7.SP.3.8.c

Represent sample spaces for compound events
using methods such as organized lists, tables and
tree diagrams. For an event described in everyday
language (e.g., “rolling double sixes”), identify the
outcomes in the sample space which compose the
event.
Represent sample spaces for compound events
using methods such as organized lists, tables and
tree diagrams. For an event described in everyday
language (e.g., “rolling double sixes”), identify the
outcomes in the sample space which compose the
event.
Design and use a simulation to generate
frequencies for compound events.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Probability of Multiple Events > Explore Compound Probabilities > Discover >
Investigate > Investigation 2: Making a Random Playlist
https://app.discoveryeducation.com/learn/techbook/units/737f33b4-2d184574-8ca6-473b3c8a5458/concepts/da9248db-e46a-4e32-a25193a3e24896fc/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/98703019-9576-4c73-b4b9-78f4b2d13ae8
Probability of Multiple Events > Explore Compound Probabilities > Discover >
Investigate > Investigation 3: Candy Conundrum
https://app.discoveryeducation.com/learn/techbook/units/737f33b4-2d184574-8ca6-473b3c8a5458/concepts/da9248db-e46a-4e32-a25193a3e24896fc/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/ea5060f4-dbc8-415a-bc98-db8afa56d0de
Probability of Multiple Events > Determine Compound Probabilities >
Discover > Investigate > Investigation 3: Choosing from a Box of Chocolates
https://app.discoveryeducation.com/learn/techbook/units/737f33b4-2d184574-8ca6-473b3c8a5458/concepts/c84e2fcc-611f-4751-96c8ddf160de9cb9/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/1af9210a-21f4-4508-ad8f-cde29b309887
Probability of Multiple Events > Determine Compound Probabilities >
Discover > Investigate > Investigation 3: Choosing from a Box of Chocolates
https://app.discoveryeducation.com/learn/techbook/units/737f33b4-2d184574-8ca6-473b3c8a5458/concepts/c84e2fcc-611f-4751-96c8ddf160de9cb9/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/1af9210a-21f4-4508-ad8f-cde29b309887

BENCHMARK CODE

BENCHMARK

MAFS.7.SP.3.8.c

Design and use a simulation to generate
frequencies for compound events.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Probability of Multiple Events > Explore Compound Probabilities > Discover >
Investigate > Investigation 1: Probability of Independent Events

Design and use a simulation to generate
frequencies for compound events.

https://app.discoveryeducation.com/learn/techbook/units/737f33b4-2d184574-8ca6-473b3c8a5458/concepts/da9248db-e46a-4e32-a25193a3e24896fc/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/91aa4dd9-98cd-42ae-9944-86215d8c857a
Probability of Multiple Events > Explore Compound Probabilities > Discover >
Investigate > Investigation 2: Making a Random Playlist

MAFS.7.SP.3.8.c

MAFS.8.EE.1.1

MAFS.8.EE.1.1

Know and apply the properties of integer
exponents to generate equivalent numerical
expressions.

Know and apply the properties of integer
exponents to generate equivalent numerical
expressions.

https://app.discoveryeducation.com/learn/techbook/units/737f33b4-2d184574-8ca6-473b3c8a5458/concepts/da9248db-e46a-4e32-a25193a3e24896fc/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/98703019-9576-4c73-b4b9-78f4b2d13ae8
Real Numbers > Investigate Square Roots and Cube Roots > Discover >
Investigate > Investigation 2: What is perfection?
https://app.discoveryeducation.com/learn/techbook/units/af0b44c4-f7f748ae-b9bb-241f35de095e/concepts/70aa0bcb-6c87-46e7-acbb2919cb514e76/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/c87281d0-4738-4b33-9403-1b7eee51b625
Exponents > Understand Rules of Exponents > Discover > Investigate >
Investigation 2: What's the Pattern
https://app.discoveryeducation.com/learn/techbook/units/014e6947-c24b4c5d-bd55-60139d53bdb0/concepts/1031e796-a180-404b-80bab81e4ed0778a/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/13947899-7469-4c37-af0f-96c4b44b1bae

BENCHMARK CODE

BENCHMARK

MAFS.8.EE.1.1

Know and apply the properties of integer
exponents to generate equivalent numerical
expressions.

MAFS.8.EE.1.2

MAFS.8.EE.1.2

MAFS.8.EE.1.3

Use square root and cube root symbols to
represent solutions to equations of the form
ùòπ¬≤ = ùò± and ùòπ¬≥ = ùò±, where ùò± is
a positive rational number. Evaluate square roots
of small perfect squares and cube roots of small
perfect cubes. Know that ‚àö2 is irrational.
Use square root and cube root symbols to
represent solutions to equations of the form
ùòπ¬≤ = ùò± and ùòπ¬≥ = ùò±, where ùò± is
a positive rational number. Evaluate square roots
of small perfect squares and cube roots of small
perfect cubes. Know that ‚àö2 is irrational.
Use numbers expressed in the form of a single
digit times an integer power of 10 to estimate
very large or very small quantities, and to express
how many times as much one is than the other.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Exponents > Understand Negative Exponents > Discover > Investigate >
Investigation 2: Exponent Detective
https://app.discoveryeducation.com/learn/techbook/units/014e6947-c24b4c5d-bd55-60139d53bdb0/concepts/96477290-647b-4efa-bf23890097cb5cf2/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/2c8195cb-ce7f-4859-afc5-3927105a657a
Real Numbers > Compare Rational and Irrational Numbers > Discover >
Investigate > Investigation 3: Zooming In > If…then…
https://app.discoveryeducation.com/learn/techbook/units/af0b44c4-f7f748ae-b9bb-241f35de095e/concepts/615209e6-3972-4826-837c923ee2eaf27b/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/c2d62833-0cd2-4f2a-8ca6-1763d760c2e7
Real Numbers > Compare Rational and Irrational Numbers > Discover >
Investigate > Investigation 1: Which One is Not Like the Others?
https://app.discoveryeducation.com/learn/techbook/units/af0b44c4-f7f748ae-b9bb-241f35de095e/concepts/615209e6-3972-4826-837c923ee2eaf27b/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/2be6e827-00fa-42c7-867b-092b960a93e8
Scientific Notation > Represent Large and Small Numbers > Discover >
Investigate > Investigation 1: Compact It!
https://app.discoveryeducation.com/learn/techbook/units/2e07479f-63e54f2b-a4a1-fc18d4f27875/concepts/8b97a8e7-079d-4b74-8eedbc9e3e0d5394/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/548fdc38-cd7f-4fc3-90b1-b2d5ec1ecb0e

BENCHMARK CODE

BENCHMARK

MAFS.8.EE.1.3

Use numbers expressed in the form of a single
digit times an integer power of 10 to estimate
very large or very small quantities, and to express
how many times as much one is than the other.

MAFS.8.EE.1.3

MAFS.8.EE.1.4

MAFS.8.EE.1.4

Use numbers expressed in the form of a single
digit times an integer power of 10 to estimate
very large or very small quantities, and to express
how many times as much one is than the other.

Perform operations with numbers expressed in
scientific notation, including problems where both
decimal and scientific notation are used. Use
scientific notation and choose units of appropriate
size for measurements of very large or very small
quantities (e.g., use millimeters per year for
seafloor spreading). Interpret scientific notation
that has been generated by technology.
Perform operations with numbers expressed in
scientific notation, including problems where both
decimal and scientific notation are used. Use
scientific notation and choose units of appropriate
size for measurements of very large or very small
quantities (e.g., use millimeters per year for
seafloor spreading). Interpret scientific notation
that has been generated by technology.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Scientific Notation > Represent Large and Small Numbers > Discover >
Investigate > Investigation 2: Dragon Study
https://app.discoveryeducation.com/learn/techbook/units/2e07479f-63e54f2b-a4a1-fc18d4f27875/concepts/8b97a8e7-079d-4b74-8eedbc9e3e0d5394/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/1890d588-91e6-413e-a1b0-34cb4e4a5ac7
Scientific Notation > Represent Large and Small Numbers > Discover >
Investigate > Investigation 3: How Do You Write That?
https://app.discoveryeducation.com/learn/techbook/units/2e07479f-63e54f2b-a4a1-fc18d4f27875/concepts/8b97a8e7-079d-4b74-8eed-bc9e3
Scientific Notation > Perform Operations Using Scientific Notation > Discover
> Investigate > Investigation 1: With a Feather on Top
https://app.discoveryeducation.com/learn/techbook/units/2e07479f-63e54f2b-a4a1-fc18d4f27875/concepts/92421269-31ea-42d0-b47b578cedac070c/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/8336c068-39c2-4c25-bb6f-47f90bbbbc00
Scientific Notation > Perform Operations Using Scientific Notation > Discover
> Investigate > Investigation 2: Write It Right
https://app.discoveryeducation.com/learn/techbook/units/2e07479f-63e54f2b-a4a1-fc18d4f27875/concepts/92421269-31ea-42d0-b47b578cedac070c/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/579af444-ae87-44a1-a130-22cda5699da5

BENCHMARK CODE

BENCHMARK

MAFS.8.EE.1.4

Perform operations with numbers expressed in
scientific notation, including problems where both
decimal and scientific notation are used. Use
scientific notation and choose units of appropriate
size for measurements of very large or very small
quantities (e.g., use millimeters per year for
seafloor spreading). Interpret scientific notation
that has been generated by technology.
Perform operations with numbers expressed in
scientific notation, including problems where both
decimal and scientific notation are used. Use
scientific notation and choose units of appropriate
size for measurements of very large or very small
quantities (e.g., use millimeters per year for
seafloor spreading). Interpret scientific notation
that has been generated by technology.
Graph proportional relationships, interpreting the
unit rate as the slope of the graph. Compare two
different proportional relationships represented
in different ways.

MAFS.8.EE.1.4

MAFS.8.EE.2.5

MAFS.8.EE.2.5

Graph proportional relationships, interpreting the
unit rate as the slope of the graph. Compare two
different proportional relationships represented
in different ways.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Scientific Notation > Perform Operations Using Scientific Notation > Discover
> Investigate > Investigation 3: Name That Pattern > Hands-on Activity:
Multiplying and Dividing with Scientific Notation
https://app.discoveryeducation.com/learn/player/104b8013-7725-45e4ab0f-684a9fcf857d
Scientific Notation > Represent Large and Small Numbers > Discover >
Investigate > Extension: Convert It!
https://app.discoveryeducation.com/learn/techbook/units/2e07479f-63e54f2b-a4a1-fc18d4f27875/concepts/8b97a8e7-079d-4b74-8eedbc9e3e0d5394/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/73f467e1-489d-4fda-a3cf-ffb17eae06a3
Introduction to Functions > Represent Proportional Relationships > Discover
> Investigate > Investigation 1:Getting to School
https://app.discoveryeducation.com/learn/techbook/units/a96818f5-c22649ec-bc78-a0594707de88/concepts/bcea2e30-74a4-4500-84bc6d4470261b4a/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/4b030e18-6ebd-4c2d-bf06-4c9553985bb8
Introduction to Functions > Represent Proportional Relationships > Discover
> Investigate > Investigation 2: Similar Triangles and Slope
https://app.discoveryeducation.com/learn/techbook/units/a96818f5-c22649ec-bc78-a0594707de88/concepts/bcea2e30-74a4-4500-84bc6d4470261b4a/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/3d591f76-a989-4fcb-b3af-e959411dc3fa

BENCHMARK CODE

BENCHMARK

MAFS.8.EE.2.5

Graph proportional relationships, interpreting the
unit rate as the slope of the graph. Compare two
different proportional relationships represented
in different ways.

MAFS.8.EE.2.6

MAFS.8.EE.2.6

MAFS.8.EE.2.6

Use similar triangles to explain why the slope m is
the same between any two distinct points on a
non-vertical line in the coordinate plane; derive
the equation ùò∫ = ùòÆùòπ for a line through
the origin and the equation ùò∫ = ùòÆùòπ +
ùò£ for a line intercepting the vertical axis at
ùò£.
Use similar triangles to explain why the slope m is
the same between any two distinct points on a
non-vertical line in the coordinate plane; derive
the equation ùò∫ = ùòÆùòπ for a line through
the origin and the equation ùò∫ = ùòÆùòπ +
ùò£ for a line intercepting the vertical axis at
ùò£.
Use similar triangles to explain why the slope m is
the same between any two distinct points on a
non-vertical line in the coordinate plane; derive
the equation ùò∫ = ùòÆùòπ for a line through
the origin and the equation ùò∫ = ùòÆùòπ +
ùò£ for a line intercepting the vertical axis at
ùò£.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Introduction to Functions > Represent Proportional Relationships > Discover
> Investigate > Investigation 3: Rate of Change and Slope
https://app.discoveryeducation.com/learn/techbook/units/a96818f5-c22649ec-bc78-a0594707de88/concepts/bcea2e30-74a4-4500-84bc6d4470261b4a/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/2485c9d5-4ca4-4b5d-a812-58d1cf3635e4
Introduction to Functions > Understand Linear Functions > Discover >
Investigate > Investigation 1: Graphing Toothpick Triangles
https://app.discoveryeducation.com/learn/techbook/units/a96818f5-c22649ec-bc78-a0594707de88/concepts/1353d0c0-4593-4166-92d0bf5789685d58/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/0b58c2c8-6f4d-4e17-84ee-beb6663441df
Introduction to Functions > Understand Linear Functions > Discover >
Investigate > Investigation 2: Translations of y = mx
https://app.discoveryeducation.com/learn/techbook/units/a96818f5-c22649ec-bc78-a0594707de88/concepts/1353d0c0-4593-4166-92d0bf5789685d58/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/3db37d23-52ca-4a25-81fb-053c6d3cd6d5
Introduction to Functions > Understand Linear Functions > Extension:
Explore Graphs
https://app.discoveryeducation.com/learn/techbook/units/a96818f5-c22649ec-bc78-a0594707de88/concepts/1353d0c0-4593-4166-92d0bf5789685d58/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/9ed0c9a1-e147-4dca-be86-49ed567ea265

BENCHMARK CODE

BENCHMARK

MAFS.8.EE.3.7.a

Give examples of linear equations in one variable
with one solution, infinitely many solutions, or no
solutions. Show which of these possibilities is the
case by successively transforming the given
equation into simpler forms, until an equivalent
equation of the form ùòπ = ùò¢, ùò¢ = ùò¢,
or ùò¢ = ùò£ results (where ùò¢ and ùò£ are
different numbers).
Give examples of linear equations in one variable
with one solution, infinitely many solutions, or no
solutions. Show which of these possibilities is the
case by successively transforming the given
equation into simpler forms, until an equivalent
equation of the form ùòπ = ùò¢, ùò¢ = ùò¢,
or ùò¢ = ùò£ results (where ùò¢ and ùò£ are
different numbers).
Give examples of linear equations in one variable
with one solution, infinitely many solutions, or no
solutions. Show which of these possibilities is the
case by successively transforming the given
equation into simpler forms, until an equivalent
equation of the form ùòπ = ùò¢, ùò¢ = ùò¢,
or ùò¢ = ùò£ results (where ùò¢ and ùò£ are
different numbers).
Solve linear equations with rational number
coefficients, including equations whose solutions
require expanding expressions using the
distributive property and collecting like terms.

MAFS.8.EE.3.7.a

MAFS.8.EE.3.7.a

MAFS.8.EE.3.7.b

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Linear Relationships> Solve Linear Equations Algebraically > Investigation 1:
Model it, Solve it, Build it!
https://app.discoveryeducation.com/learn/techbook/units/9103230a-7c7746f7-9886-e76fdb31dee0/concepts/88d3387d-6603-4c5c-a37ed2f4b8d56a63/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/d153affd-958f-4009-bba5-33cd39bd6783
Linear Relationships > Solve Linear Equations Algebraically > Investigation 2:
Solve Equations for a Specific Variable
https://app.discoveryeducation.com/learn/techbook/units/9103230a-7c7746f7-9886-e76fdb31dee0/concepts/88d3387d-6603-4c5c-a37ed2f4b8d56a63/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/025b76f1-e3ef-4c3d-902c-635b1ea93e0c
Linear Relationships > Solve Linear Equations Algebraically > Investigation 3:
Number of Solutions
https://app.discoveryeducation.com/learn/techbook/units/9103230a-7c7746f7-9886-e76fdb31dee0/concepts/88d3387d-6603-4c5c-a37ed2f4b8d56a63/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/68a10a42-6d5c-4066-a92f-62f9206010f2
Linear Relationships > Explore Linear Functions and Linear Equations >
Discover > Investigate > Investigation 1: Functions and Tables
https://app.discoveryeducation.com/learn/techbook/units/9103230a-7c7746f7-9886-e76fdb31dee0/concepts/f4dc58af-d865-4865-98ab8434276d4920/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/8dc358ec-41e0-4349-a822-a2b8ba316b8e

BENCHMARK CODE

BENCHMARK

MAFS.8.EE.3.7.b

Solve linear equations with rational number
coefficients, including equations whose solutions
require expanding expressions using the
distributive property and collecting like terms.

MAFS.8.EE.3.7.b

MAFS.8.EE.3.8.a

MAFS.8.EE.3.8.a

Solve linear equations with rational number
coefficients, including equations whose solutions
require expanding expressions using the
distributive property and collecting like terms.

Understand that solutions to a system of two
linear equations in two variables correspond to
points of intersection of their graphs, because
points of intersection satisfy both equations
simultaneously.
Understand that solutions to a system of two
linear equations in two variables correspond to
points of intersection of their graphs, because
points of intersection satisfy both equations
simultaneously.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Linear Relationships > Solve Linear Equations Algebraically > Discover >
Investigate > Investigation 4: Comparing Solution Methods
https://app.discoveryeducation.com/learn/techbook/units/9103230a-7c7746f7-9886-e76fdb31dee0/concepts/88d3387d-6603-4c5c-a37ed2f4b8d56a63/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/4925057c-d633-4719-9c44-944c18522f47
Linear Relationships > Solve Linear Equations Algebraically > Investigation 2:
Solving Equations for a Specific Variable
https://app.discoveryeducation.com/learn/techbook/units/9103230a-7c7746f7-9886-e76fdb31dee0/concepts/88d3387d-6603-4c5c-a37ed2f4b8d56a63/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/025b76f1-e3ef-4c3d-902c-635b1ea93e0c
Linear Systems > Model Situations with Multiple Equations > Discover >
Investigate > Investigation 1: When Will the Runners Cross Paths? > Handson Activity: When Will the Runners Cross Paths?
https://app.discoveryeducation.com/learn/player/bf580a0f-bb46-4d399efc-b01b66f6807f
Linear Systems > Model Situations with Multiple Equations > Discover >
Investigate > Investigation 2: The Solutions to Graphs of Systems
https://app.discoveryeducation.com/learn/techbook/units/27a72144-87814826-9df8-1f2a1a469105/concepts/d701728c-7ce7-4640-a1a922d8ed8253ef/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/ac622a94-89e3-45bc-a553-d7f6a34c7353

BENCHMARK CODE

BENCHMARK

MAFS.8.EE.3.8.a

Understand that solutions to a system of two
linear equations in two variables correspond to
points of intersection of their graphs, because
points of intersection satisfy both equations
simultaneously.

MAFS.8.EE.3.8.b

MAFS.8.EE.3.8.b

MAFS.8.EE.3.8.b

Solve systems of two linear equations in two
variables algebraically, and estimate solutions by
graphing the equations. Solve simple cases by
inspection.

Solve systems of two linear equations in two
variables algebraically, and estimate solutions by
graphing the equations. Solve simple cases by
inspection.

Solve systems of two linear equations in two
variables algebraically, and estimate solutions by
graphing the equations. Solve simple cases by
inspection.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Linear Systems > Model Situations with Multiple Equations > Discover >
Investigate > Investigation 3: Mixture Mysteries
https://app.discoveryeducation.com/learn/techbook/units/27a72144-87814826-9df8-1f2a1a469105/concepts/d701728c-7ce7-4640-a1a922d8ed8253ef/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/cc8210bb-9a3c-4b41-b053-a4bc5ad18a40
Linear Systems > Model Situations with Multiple Equations > Discover >
Investigate > Investigation 4: Substitution
https://app.discoveryeducation.com/learn/techbook/units/27a72144-87814826-9df8-1f2a1a469105/concepts/d701728c-7ce7-4640-a1a922d8ed8253ef/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/e05e006e-f128-492c-9af1-4b960d5ba69b
Linear Systems > Model Situations with Multiple Equations > Discover >
Investigate > Investigation 5: Elimination
https://app.discoveryeducation.com/learn/techbook/units/27a72144-87814826-9df8-1f2a1a469105/concepts/d701728c-7ce7-4640-a1a922d8ed8253ef/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/581e2ce7-2e4b-4c47-91d1-ceff13bd2a21
Linear Systems > Model Situations with Multiple Equations > Discover >
Investigate > Investigation 6: Elimination or Substitution
https://app.discoveryeducation.com/learn/techbook/units/27a72144-87814826-9df8-1f2a1a469105/concepts/d701728c-7ce7-4640-a1a922d8ed8253ef/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/16aa9dd6-e991-4d93-82c3-2f6f44796033

BENCHMARK CODE

BENCHMARK

MAFS.8.EE.3.8.c

Solve real-world and mathematical problems
leading to two linear equations in two variables.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Linear Systems > Model Situations with Multiple Equations > Apply > Apply
1: How Does the Wind Affect Flight Times?

Solve real-world and mathematical problems
leading to two linear equations in two variables.

https://app.discoveryeducation.com/learn/techbook/units/27a72144-87814826-9df8-1f2a1a469105/concepts/d701728c-7ce7-4640-a1a922d8ed8253ef/tabs/6dc41756-43ff-4f63-bd113148dd938983/pages/c66a2fb3-3659-4c75-90e4-8da8546c3f1d
Linear Systems > Model Situations with Multiple Equations > Apply > Apply
2: How Much Will Each Pet Cost?

Solve real-world and mathematical problems
leading to two linear equations in two variables.

https://app.discoveryeducation.com/learn/techbook/units/27a72144-87814826-9df8-1f2a1a469105/concepts/d701728c-7ce7-4640-a1a922d8ed8253ef/tabs/6dc41756-43ff-4f63-bd113148dd938983/pages/a0386d40-3c90-4f82-bb7c-e8c0afff1516
Linear Systems > Model Situations with Multiple Equations > Discover >
Investigate > Investigation 3: Mixture Mysteries

MAFS.8.EE.3.8.c

MAFS.8.EE.3.8.c

MAFS.8.F.1.1

Understand that a function is a rule that assigns to
each input exactly one output. The graph of a
function is the set of ordered pairs consisting of
an input and the corresponding output.

https://app.discoveryeducation.com/learn/techbook/units/27a72144-87814826-9df8-1f2a1a469105/concepts/d701728c-7ce7-4640-a1a922d8ed8253ef/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/cc8210bb-9a3c-4b41-b053-a4bc5ad18a40
Introduction to Functions > Graph, Describe, and Analyze Functions >
Discover > Investigate > Investigation 4: Function Behavior
https://app.discoveryeducation.com/learn/techbook/units/a96818f5-c22649ec-bc78-a0594707de88/concepts/0218dae9-0f49-4f12-baee2fa9bad4cf8d/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/7185dcd8-1e1b-455b-afcc-b3c8597729bf

BENCHMARK CODE

BENCHMARK

MAFS.8.F.1.1

Understand that a function is a rule that assigns to
each input exactly one output. The graph of a
function is the set of ordered pairs consisting of
an input and the corresponding output.

MAFS.8.F.1.1

MAFS.8.F.1.2

MAFS.8.F.1.2

Understand that a function is a rule that assigns to
each input exactly one output. The graph of a
function is the set of ordered pairs consisting of
an input and the corresponding output.

Compare properties of two functions each
represented in a different way (algebraically,
graphically, numerically in tables, or by verbal
descriptions).

Compare properties of two functions each
represented in a different way (algebraically,
graphically, numerically in tables, or by verbal
descriptions).

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Introduction to Functions > Understand Linear Functions > Discover >
Investigate > Investigation 3: Undefined Slope and Zero Slope
https://app.discoveryeducation.com/learn/techbook/units/a96818f5-c22649ec-bc78-a0594707de88/concepts/1353d0c0-4593-4166-92d0bf5789685d58/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/2aab51d4-86ef-4b8f-a137-fc0c28a32884
Introduction to Functions > Investigate Properties of Functions > Discover >
Investigate > Investigation 1: What is a Function?
https://app.discoveryeducation.com/learn/techbook/units/a96818f5-c22649ec-bc78-a0594707de88/concepts/7ebfe015-0ff0-4dc3-93c06fd551b51c60/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/b301d6d1-e4e3-45e1-b205-7afcc0802b07
Introduction to Functions > Understand Linear Functions > Discover >
Investigate > Investigation 2: Translations of y = mx > Comparing Scenarios
https://app.discoveryeducation.com/learn/techbook/units/a96818f5-c22649ec-bc78-a0594707de88/concepts/1353d0c0-4593-4166-92d0bf5789685d58/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/3db37d23-52ca-4a25-81fb-053c6d3cd6d5
Introduction to Functions > Graph, Describe, and Analyze Functions >
Discover > Investigate > Investigation 3: Compare Perimeter and Area
https://app.discoveryeducation.com/learn/techbook/units/a96818f5-c22649ec-bc78-a0594707de88/concepts/0218dae9-0f49-4f12-baee2fa9bad4cf8d/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/ebba3bda-a28d-4b80-9209-8d36594f0d71

BENCHMARK CODE

BENCHMARK

MAFS.8.F.1.2

Compare properties of two functions each
represented in a different way (algebraically,
graphically, numerically in tables, or by verbal
descriptions).

MAFS.8.F.1.3

MAFS.8.F.1.3

MAFS.8.F.1.3

Interpret the equation ùò∫ = ùòÆùòπ + ùò£
as defining a linear function, whose graph is a
straight line; give examples of functions that are
not linear.

Interpret the equation ùò∫ = ùòÆùòπ + ùò£
as defining a linear function, whose graph is a
straight line; give examples of functions that are
not linear.

Interpret the equation ùò∫ = ùòÆùòπ + ùò£
as defining a linear function, whose graph is a
straight line; give examples of functions that are
not linear.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Introduction to Functions > Investigate Properties of Functions > Discover >
Investigate > Investigation 4: Match the Function > Hands-On Activity:
Matching Functions Game
https://app.discoveryeducation.com/learn/player/bc49369d-7885-403999a1-60be677be2f9
Introduction to Functions > Graph, Describe, and Analyze Functions >
Discover > Investigate > Investigation 3: Compare Perimeter and Area
https://app.discoveryeducation.com/learn/techbook/units/a96818f5-c22649ec-bc78-a0594707de88/concepts/0218dae9-0f49-4f12-baee2fa9bad4cf8d/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/ebba3bda-a28d-4b80-9209-8d36594f0d71
Introduction to Functions > Understand Linear Functions > Discover >
Investigate > Investigation 2: Translations of y = mx > Job Earnings with
Bonus
https://app.discoveryeducation.com/learn/techbook/units/a96818f5-c22649ec-bc78-a0594707de88/concepts/1353d0c0-4593-4166-92d0bf5789685d58/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/3db37d23-52ca-4a25-81fb-053c6d3cd6d5
Introduction to Functions > Represent Proportional Relationships > Discover
> Investigate > Extension
https://app.discoveryeducation.com/learn/techbook/units/a96818f5-c22649ec-bc78-a0594707de88/concepts/bcea2e30-74a4-4500-84bc6d4470261b4a/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/ddffb48c-79a0-414c-9bda-0271b1823864

BENCHMARK CODE

BENCHMARK

MAFS.8.F.2.4

Construct a function to model a linear relationship
between two quantities. Determine the rate of
change and initial value of the function from a
description of a relationship or from two (ùòπ,
ùò∫) values, including reading these from a table
or from a graph. Interpret the rate of change and
initial value of a linear function in terms of the
situation it models, and in terms of its graph or a
table of values.
Construct a function to model a linear relationship
between two quantities. Determine the rate of
change and initial value of the function from a
description of a relationship or from two (ùòπ,
ùò∫) values, including reading these from a table
or from a graph. Interpret the rate of change and
initial value of a linear function in terms of the
situation it models, and in terms of its graph or a
table of values.
Construct a function to model a linear relationship
between two quantities. Determine the rate of
change and initial value of the function from a
description of a relationship or from two (ùòπ,
ùò∫) values, including reading these from a table
or from a graph. Interpret the rate of change and
initial value of a linear function in terms of the
situation it models, and in terms of its graph or a
table of values.

MAFS.8.F.2.4

MAFS.8.F.2.4

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Introduction to Functions > Understand Linear Functions > Discover >
Investigate > Investigation 4: Linear Functions
https://app.discoveryeducation.com/learn/techbook/units/a96818f5-c22649ec-bc78-a0594707de88/concepts/1353d0c0-4593-4166-92d0bf5789685d58/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/d5b9201b-d268-4122-adda-a56221e20fb6
Linear Relationships > Explore Linear Functions and Linear Equations > Apply
> Apply 1: How Can You Use the Length of a Humerus to Approximate
Height?
https://app.discoveryeducation.com/learn/techbook/units/9103230a-7c7746f7-9886-e76fdb31dee0/concepts/f4dc58af-d865-4865-98ab8434276d4920/tabs/6dc41756-43ff-4f63-bd113148dd938983/pages/63516c3d-8e69-43b9-b8d5-d99667e7c988
Introduction to Functions > Represent Proportional Relationships > Discover
> Investigate > Investigation 1: Getting to School
https://app.discoveryeducation.com/learn/techbook/units/a96818f5-c22649ec-bc78-a0594707de88/concepts/bcea2e30-74a4-4500-84bc6d4470261b4a/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/4b030e18-6ebd-4c2d-bf06-4c9553985bb8

BENCHMARK CODE

BENCHMARK

MAFS.8.F.2.4

Construct a function to model a linear relationship
between two quantities. Determine the rate of
change and initial value of the function from a
description of a relationship or from two (ùòπ,
ùò∫) values, including reading these from a table
or from a graph. Interpret the rate of change and
initial value of a linear function in terms of the
situation it models, and in terms of its graph or a
table of values.
Describe qualitatively the functional relationship
between two quantities by analyzing a graph (e.g.,
where the function is increasing or decreasing,
linear or nonlinear). Sketch a graph that exhibits
the qualitative features of a function that has
been described verbally.

MAFS.8.F.2.5

MAFS.8.F.2.5

MAFS.8.F.2.5

Describe qualitatively the functional relationship
between two quantities by analyzing a graph (e.g.,
where the function is increasing or decreasing,
linear or nonlinear). Sketch a graph that exhibits
the qualitative features of a function that has
been described verbally.
Describe qualitatively the functional relationship
between two quantities by analyzing a graph (e.g.,
where the function is increasing or decreasing,
linear or nonlinear). Sketch a graph that exhibits
the qualitative features of a function that has
been described verbally.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Introduction to Functions > Investigate Properties of Functions > Discover >
Investigate > Investigation 2: It's Functional > Hands-on Activity: It's
Functional
https://app.discoveryeducation.com/learn/player/b0ccba94-da86-4798ad25-ff117306878d

Introduction to Functions > Understand Linear Functions > Apply > Apply 3:
How Can You Model Real-World Functions?
https://app.discoveryeducation.com/learn/techbook/units/a96818f5-c22649ec-bc78-a0594707de88/concepts/1353d0c0-4593-4166-92d0bf5789685d58/tabs/6dc41756-43ff-4f63-bd113148dd938983/pages/cebae879-6397-4711-8011-c69d4bd8f195
Introduction to Functions > Graph, Describe, and Analyze Functions >
Discover > Investigate > Investigation 4: Function Behavior > Part 2
https://app.discoveryeducation.com/learn/techbook/units/a96818f5-c22649ec-bc78-a0594707de88/concepts/0218dae9-0f49-4f12-baee2fa9bad4cf8d/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/7185dcd8-1e1b-455b-afcc-b3c8597729bf
Introduction to Functions > Investigate Properties of Functions > Discover >
Investigate > Investigation 4: Match the Function > Hands-On Activity:
Matching Functions Game
https://app.discoveryeducation.com/learn/player/bc49369d-7885-403999a1-60be677be2f9

BENCHMARK CODE

BENCHMARK

MAFS.8.F.2.5

Describe qualitatively the functional relationship
between two quantities by analyzing a graph (e.g.,
where the function is increasing or decreasing,
linear or nonlinear). Sketch a graph that exhibits
the qualitative features of a function that has
been described verbally.

MAFS.8.G.1.1.a

MAFS.8.G.1.1.a

MAFS.8.G.1.1.a

Lines are taken to lines, and line segments to line
segments of the same length.

Lines are taken to lines, and line segments to line
segments of the same length.

Lines are taken to lines, and line segments to line
segments of the same length.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Linear Relationships > Explore Linear Functions and Linear Equations > Apply
> Apply 3: How Can You Make Plans for a Gigantic Work of Art? > Analyze a
Graph
https://app.discoveryeducation.com/learn/techbook/units/9103230a-7c7746f7-9886-e76fdb31dee0/concepts/f4dc58af-d865-4865-98ab8434276d4920/tabs/6dc41756-43ff-4f63-bd113148dd938983/pages/bdd3edae-c743-4129-bdcd-021ca0cd70c4
Congruence and Similarity > Investigate Geometric Transformations >
Discover > Investigate > Investigation 2: Action Figures > Transforming a Line
Segment
https://app.discoveryeducation.com/learn/techbook/units/9ea0d93a-3a1c494b-9626-f1170be6310c/concepts/e6ce97a5-3790-4781-a0d47d24eff3d7a4/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/b018f3d1-8ba4-4aab-b434-34e2f6039feb
Congruence and Similarity > Perform Multiple Transformations > Discover >
Investigate > Investigation 1: Multiple Transformations > Analyze
Transformations
https://app.discoveryeducation.com/learn/techbook/units/9ea0d93a-3a1c494b-9626-f1170be6310c/concepts/e78f761c-01f1-4e90-8f0196d31975a846/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/a004bfc0-37c9-4367-9724-7525df756d31
Intersecting Lines and Angles > Investigate Parallel and Intersecting Lines >
Discover > Investigate > Investigation 3: Lines Angles and Triangles
https://app.discoveryeducation.com/learn/techbook/units/178d1a83-54e04c10-8ceb-03a0f80c75aa/concepts/9a45e54c-fbde-4976-b86a71ee58c86afb/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/78cdb766-16da-4617-9561-b4a62dd9f856

BENCHMARK CODE

BENCHMARK

MAFS.8.G.1.1.b

Angles are taken to angles of the same measure.

MAFS.8.G.1.1.b

MAFS.8.G.1.1.b

MAFS.8.G.1.1.c

Angles are taken to angles of the same measure.

Angles are taken to angles of the same measure.

Parallel lines are taken to parallel lines.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Congruence and Similarity > Investigate Geometric Transformations >
Discover > Investigate > Investigation 1: Triangle Patterns > Hands-on
Activity: Triangle Patterns
https://app.discoveryeducation.com/learn/techbook/units/9ea0d93a-3a1c494b-9626-f1170be6310c/concepts/e6ce97a5-3790-4781-a0d47d24eff3d7a4/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/9c8f2866-c2ae-459b-b577-1312d93c6ae9
Congruence and Similarity > Perform Multiple Transformations > Discover >
Investigate > Investigation 1: Multiple Transformations > Analyze
Transformations
https://app.discoveryeducation.com/learn/techbook/units/9ea0d93a-3a1c494b-9626-f1170be6310c/concepts/e78f761c-01f1-4e90-8f0196d31975a846/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/a004bfc0-37c9-4367-9724-7525df756d31
Intersecting Lines and Angles > Investigate Parallel and Intersecting Lines >
Discover > Investigate > Investigation 3: Lines Angles and Triangles
https://app.discoveryeducation.com/learn/techbook/units/178d1a83-54e04c10-8ceb-03a0f80c75aa/concepts/9a45e54c-fbde-4976-b86a71ee58c86afb/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/78cdb766-16da-4617-9561-b4a62dd9f856
Congruence and Similarity > Investigate Geometric Transformations >
Discover > Investigate > Investigation 3: Action Figures in the Coordinate
Plane > translating Two-dimensional Figures in the Coordinate Plane
https://app.discoveryeducation.com/learn/techbook/units/9ea0d93a-3a1c494b-9626-f1170be6310c/concepts/e6ce97a5-3790-4781-a0d47d24eff3d7a4/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/b7336a5e-cfd4-495c-ae2c-cb34bcf2c119

BENCHMARK CODE

BENCHMARK

MAFS.8.G.1.1.c

Parallel lines are taken to parallel lines.

MAFS.8.G.1.1.c

MAFS.8.G.1.2

MAFS.8.G.1.2

Parallel lines are taken to parallel lines.

Understand that a two-dimensional figure is
congruent to another if the second can be
obtained from the first by a sequence of
rotations, reflections, and translations; given two
congruent figures, describe a sequence that
exhibits the congruence between them.
Understand that a two-dimensional figure is
congruent to another if the second can be
obtained from the first by a sequence of
rotations, reflections, and translations; given two
congruent figures, describe a sequence that
exhibits the congruence between them.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Congruence and Similarity > Perform Multiple Transformations > Discover >
Investigate > Investigation 1: Multiple Transformations > Reflect and
Translate a Quadrilateral
https://app.discoveryeducation.com/learn/techbook/units/9ea0d93a-3a1c494b-9626-f1170be6310c/concepts/e78f761c-01f1-4e90-8f0196d31975a846/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/a004bfc0-37c9-4367-9724-7525df756d31
Congruence and Similarity > Perform Multiple Transformations > Discover >
Investigate > Investigation 2: Matching Figures
https://app.discoveryeducation.com/learn/techbook/units/9ea0d93a-3a1c494b-9626-f1170be6310c/concepts/e78f761c-01f1-4e90-8f0196d31975a846/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/d6f28654-31e7-42ad-87d3-b4f853df67cf
Congruence and Similarity > Perform Multiple Transformations > Discover >
Investigate > Investigation 1: Multiple Transformations > Analyze Multiple
Transformations
https://app.discoveryeducation.com/learn/techbook/units/9ea0d93a-3a1c494b-9626-f1170be6310c/concepts/e78f761c-01f1-4e90-8f0196d31975a846/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/a004bfc0-37c9-4367-9724-7525df756d31
Congruence and Similarity > Perform Multiple Transformations > Discover >
Investigate > Investigation 3: Matching Figures on the Coordinate Plane >
Describe Multiple Transformations Across the x-axis and y-axis
https://app.discoveryeducation.com/learn/techbook/units/9ea0d93a-3a1c494b-9626-f1170be6310c/concepts/e78f761c-01f1-4e90-8f0196d31975a846/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/e2d84ec7-25fb-43ef-9878-1ad28349a18d

BENCHMARK CODE

BENCHMARK

MAFS.8.G.1.2

Understand that a two-dimensional figure is
congruent to another if the second can be
obtained from the first by a sequence of
rotations, reflections, and translations; given two
congruent figures, describe a sequence that
exhibits the congruence between them.

MAFS.8.G.1.3

MAFS.8.G.1.3

MAFS.8.G.1.3

Describe the effect of dilations, translations,
rotations, and reflections on two-dimensional
figures using coordinates.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Congruence and Similarity > Perform Multiple Transformations > Discover >
Investigate > Investigation 2: Matching Figures
https://app.discoveryeducation.com/learn/techbook/units/9ea0d93a-3a1c494b-9626-f1170be6310c/concepts/e78f761c-01f1-4e90-8f0196d31975a846/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/d6f28654-31e7-42ad-87d3-b4f853df67cf
Introduction to Functions > Understand Linear Functions > Discover >
Investigate > Investigation 2: Translations of y = mx

Describe the effect of dilations, translations,
rotations, and reflections on two-dimensional
figures using coordinates.

https://app.discoveryeducation.com/learn/techbook/units/a96818f5-c22649ec-bc78-a0594707de88/concepts/1353d0c0-4593-4166-92d0bf5789685d58/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/3db37d23-52ca-4a25-81fb-053c6d3cd6d5
Congruence and Similarity > Perform Multiple Transformations > Discover >
Investigate > Investigation 3: Matching Figures on the Coordinate Plane >
Describe Multiple Transformations In the Coordinate Plane

Describe the effect of dilations, translations,
rotations, and reflections on two-dimensional
figures using coordinates.

https://app.discoveryeducation.com/learn/techbook/units/9ea0d93a-3a1c494b-9626-f1170be6310c/concepts/e78f761c-01f1-4e90-8f0196d31975a846/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/e2d84ec7-25fb-43ef-9878-1ad28349a18d
Congruence and Similarity > Investigate Geometric Transformations >
Discover > Investigate > Investigation 3: Action Figures in the Coordinate
Plane > Translating Two-dimensional Figures in the Coordinate Plane
https://app.discoveryeducation.com/learn/techbook/units/9ea0d93a-3a1c494b-9626-f1170be6310c/concepts/e6ce97a5-3790-4781-a0d47d24eff3d7a4/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/b7336a5e-cfd4-495c-ae2c-cb34bcf2c119

BENCHMARK CODE

BENCHMARK

MAFS.8.G.1.3

Describe the effect of dilations, translations,
rotations, and reflections on two-dimensional
figures using coordinates.

MAFS.8.G.1.4

MAFS.8.G.1.4

MAFS.8.G.1.4

Understand that a two-dimensional figure is
similar to another if the second can be obtained
from the first by a sequence of rotations,
reflections, translations, and dilations; given two
similar two-dimensional figures, describe a
sequence that exhibits the similarity between
them.
Understand that a two-dimensional figure is
similar to another if the second can be obtained
from the first by a sequence of rotations,
reflections, translations, and dilations; given two
similar two-dimensional figures, describe a
sequence that exhibits the similarity between
them.
Understand that a two-dimensional figure is
similar to another if the second can be obtained
from the first by a sequence of rotations,
reflections, translations, and dilations; given two
similar two-dimensional figures, describe a
sequence that exhibits the similarity between
them.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Congruence and Similarity > Represent Similarity with Proportions > Apply >
Apply 2: How Would You Make a Stencil Pattern
https://app.discoveryeducation.com/learn/techbook/units/9ea0d93a-3a1c494b-9626-f1170be6310c/concepts/3dda662e-fb4f-4fe0-b01111ef7c39257a/tabs/6dc41756-43ff-4f63-bd113148dd938983/pages/e97763a5-0103-47ef-acbd-47f82d0bf284
Congruence and Similarity > Represent Similarity with Proportions > Discover
> Investigate > Investigation 1: Sizing It Up (or Down) > Hand-On Activity:
Exploring Dilations
https://app.discoveryeducation.com/learn/player/a949b16c-0d97-4e4a85d4-d05a2985c431
Congruence and Similarity > Represent Similarity with Proportions > Discover
> Investigate > Investigation 2: All the Right Moves > Transform a Polygon
https://app.discoveryeducation.com/learn/techbook/units/9ea0d93a-3a1c494b-9626-f1170be6310c/concepts/3dda662e-fb4f-4fe0-b01111ef7c39257a/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/eeb1131d-97cd-4e70-8e34-19aa3613a697
Congruence and Similarity > Represent Similarity with Proportions > Apply >
Apply 1: Where Do You See Transformations in Art?
https://app.discoveryeducation.com/learn/techbook/units/9ea0d93a-3a1c494b-9626-f1170be6310c/concepts/3dda662e-fb4f-4fe0-b01111ef7c39257a/tabs/6dc41756-43ff-4f63-bd113148dd938983/pages/c6fa7d54-084f-4d57-ba1b-b3c842f937ec

BENCHMARK CODE

BENCHMARK

MAFS.8.G.1.5

Use informal arguments to establish facts about
the angle sum and exterior angle of triangles,
about the angles created when parallel lines are
cut by a transversal, and the angle-angle criterion
for similarity of triangles.

MAFS.8.G.1.5

MAFS.8.G.1.5

MAFS.8.G.1.5

Use informal arguments to establish facts about
the angle sum and exterior angle of triangles,
about the angles created when parallel lines are
cut by a transversal, and the angle-angle criterion
for similarity of triangles.
Use informal arguments to establish facts about
the angle sum and exterior angle of triangles,
about the angles created when parallel lines are
cut by a transversal, and the angle-angle criterion
for similarity of triangles.
Use informal arguments to establish facts about
the angle sum and exterior angle of triangles,
about the angles created when parallel lines are
cut by a transversal, and the angle-angle criterion
for similarity of triangles.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Congruence and Similarity > Represent Similarity with Proportions > Discover
> Investigate > Investigation 3: Similar Triangles > Hands-On Activity: Similar
Triangles
https://app.discoveryeducation.com/learn/player/596c1a1b-23a2-4428a59d-789b9b1561b7
The Pythagorean Theorem > Investigate the Pythagorean Theorem Converse
> Discover > Investigate > Investigation 1: Is the Rocket Perpendicular?
https://app.discoveryeducation.com/learn/techbook/units/26800a8c-8a694adf-8fee-a22e9326c226/concepts/19e354eb-c517-4794-ade4b07233107a6b/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/c71bbea6-ae0a-4e16-8e81-be3b03a3d29c
Intersecting Lines and Angles > Understand Interior and Exterior Angles >
Discover > Investigate > Investigation 2: Exploring the Exterior > Hands-On
Activity: Exploring the Exterior
https://app.discoveryeducation.com/learn/player/0f6ecbbc-dacb-47379599-cc7735dd0f80
Intersecting Lines and Angles > Investigate Parallel and Intersecting Lines >
Discover > Investigate > Investigation 1: Transversal and Parallel Lines
https://app.discoveryeducation.com/learn/techbook/units/178d1a83-54e04c10-8ceb-03a0f80c75aa/concepts/9a45e54c-fbde-4976-b86a71ee58c86afb/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/8b2a40f6-b2c4-48d6-83af-e7733b288fa7

BENCHMARK CODE

BENCHMARK

MAFS.8.G.2.6

Explain a proof of the Pythagorean Theorem and
its converse.

MAFS.8.G.2.6

MAFS.8.G.2.6

MAFS.8.G.2.7

Explain a proof of the Pythagorean Theorem and
its converse.

Explain a proof of the Pythagorean Theorem and
its converse.

Apply the Pythagorean Theorem to determine
unknown side lengths in right triangles in realworld and mathematical problems in two and
three dimensions.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
The Pythagorean Theorem > Investigate the Pythagorean Theorem >
Discover > Investigate > Investigation 2: Conduct and Experiment >
Interactive: Squares on a Triangle
https://app.discoveryeducation.com/learn/techbook/units/26800a8c-8a694adf-8fee-a22e9326c226/concepts/c93bbe5b-6081-487a-942b13c141581da6/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/b191e128-3614-4ff7-b055-dcdefdbd71bd
The Pythagorean Theorem > Investigate the Pythagorean Theorem >
Discover > Investigate > Investigation 3: Examine a Proof of the Pythagorean
Theorem
https://app.discoveryeducation.com/learn/techbook/units/26800a8c-8a694adf-8fee-a22e9326c226/concepts/c93bbe5b-6081-487a-942b13c141581da6/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/d9515e43-93d4-4820-b9bc-6e6cbcc52c5f
The Pythagorean Theorem > Investigate the Pythagorean Theorem Converse
> Discover > Investigate > Investigation 3: Informal Proofs
https://app.discoveryeducation.com/learn/techbook/units/26800a8c-8a694adf-8fee-a22e9326c226/concepts/19e354eb-c517-4794-ade4b07233107a6b/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/9e99c917-dc4d-4021-aaea-717c609c2c8b
The Pythagorean Theorem > Investigate the Pythagorean Theorem >
Discover > Investigate > Investigation 4: How Is the Pythagorean Theorem
Used to Solve Problems?
https://app.discoveryeducation.com/learn/techbook/units/26800a8c-8a694adf-8fee-a22e9326c226/concepts/c93bbe5b-6081-487a-942b13c141581da6/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/6fbdc7a7-d995-4eb1-8d4e-0bee2b84fcba

BENCHMARK CODE

BENCHMARK

MAFS.8.G.2.7

Apply the Pythagorean Theorem to determine
unknown side lengths in right triangles in realworld and mathematical problems in two and
three dimensions.

MAFS.8.G.2.7

MAFS.8.G.2.8

MAFS.8.G.2.8

Apply the Pythagorean Theorem to determine
unknown side lengths in right triangles in realworld and mathematical problems in two and
three dimensions.

Apply the Pythagorean Theorem to find the
distance between two points in a coordinate
system.

Apply the Pythagorean Theorem to find the
distance between two points in a coordinate
system.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
The Pythagorean Theorem > Use the Pythagorean Theorem in 2-D and 3-D >
Discover > Investigate > Investigation 3: Fitting a Tripod into a Box
https://app.discoveryeducation.com/learn/techbook/units/26800a8c-8a694adf-8fee-a22e9326c226/concepts/1828e238-33b5-4647-a7f26747e8c6e549/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/9e5e1fef-0c93-4543-9e91-7416ad57cfdd
The Pythagorean Theorem > Investigate the Pythagorean Theorem > Apply >
Apply 1: What Are the Dimensions of a Flat-Screen TV?
https://app.discoveryeducation.com/learn/techbook/units/26800a8c-8a694adf-8fee-a22e9326c226/concepts/c93bbe5b-6081-487a-942b13c141581da6/tabs/6dc41756-43ff-4f63-bd113148dd938983/pages/2925e6ba-e3e9-476c-8eec-19a6ef28ff43
The Pythagorean Theorem > Use the Pythagorean Theorem in 2-D and 3-D >
Discover > Investigate > Investigation 1: Finding a Route for the Courier
https://app.discoveryeducation.com/learn/techbook/units/26800a8c-8a694adf-8fee-a22e9326c226/concepts/1828e238-33b5-4647-a7f26747e8c6e549/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/3b2b5a68-ec5c-4557-b583-dd3ced98f70c
The Pythagorean Theorem > Use the Pythagorean Theorem in 2-D and 3-D >
Discover > Investigate > Investigation 2: Anandi's Method
https://app.discoveryeducation.com/learn/techbook/units/26800a8c-8a694adf-8fee-a22e9326c226/concepts/1828e238-33b5-4647-a7f26747e8c6e549/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/cf3763f8-55cb-4008-b1d1-bbcf7521a035

BENCHMARK CODE

BENCHMARK

MAFS.8.G.2.8

Apply the Pythagorean Theorem to find the
distance between two points in a coordinate
system.

MAFS.8.G.3.9

MAFS.8.G.3.9

MAFS.8.G.3.9

Know the formulas for the volumes of cones,
cylinders, and spheres and use them to solve realworld and mathematical problems.

Know the formulas for the volumes of cones,
cylinders, and spheres and use them to solve realworld and mathematical problems.

Know the formulas for the volumes of cones,
cylinders, and spheres and use them to solve realworld and mathematical problems.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
The Pythagorean Theorem > Use the Pythagorean Theorem in 2-D and 3-D >
Apply > Apply 1: What is the Shortest Path on the Map?
https://app.discoveryeducation.com/learn/techbook/units/26800a8c-8a694adf-8fee-a22e9326c226/concepts/1828e238-33b5-4647-a7f26747e8c6e549/tabs/6dc41756-43ff-4f63-bd113148dd938983/pages/ae00e236-456b-47ff-a7c6-ae389672cd42
Volume of Solid Figures > Investigate Volume Formulas > Discover >
Investigate > Investigation 2: Volume of Cylinders and Cones > Hands-on
Activity: Prisms and Cylinders >
https://app.discoveryeducation.com/learn/player/812c2901-a9ce-4342b28d-1759a3053df5
Volume of Solid Figures > Investigate Volume Formulas > Discover >
Investigate > Investigation 3: Volume of a Sphere
https://app.discoveryeducation.com/learn/techbook/units/9b962216-ccf74e86-813b-90d8042fff94/concepts/c7f089f3-4afe-44cc-9230b43aac565ab7/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/3b77469f-6dbe-45bb-afbd-c3e318533cf9
Volume of Solid Figures > Investigate Volume Formulas > Apply > Apply 2:
How Can You Turn a Cube into a Cylinder, a Cone, and a Sphere?
https://app.discoveryeducation.com/learn/techbook/units/9b962216-ccf74e86-813b-90d8042fff94/concepts/c7f089f3-4afe-44cc-9230b43aac565ab7/tabs/6dc41756-43ff-4f63-bd113148dd938983/pages/0e527ca1-16f5-4f9b-a3f2-bfe634419a99

BENCHMARK CODE

BENCHMARK

MAFS.8.NS.1.1

Know that numbers that are not rational are
called irrational. Understand informally that every
number has a decimal expansion; for rational
numbers show that the decimal expansion
repeats eventually, and convert a decimal
expansion which repeats eventually into a rational
number.
Know that numbers that are not rational are
called irrational. Understand informally that every
number has a decimal expansion; for rational
numbers show that the decimal expansion
repeats eventually, and convert a decimal
expansion which repeats eventually into a rational
number.
Know that numbers that are not rational are
called irrational. Understand informally that every
number has a decimal expansion; for rational
numbers show that the decimal expansion
repeats eventually, and convert a decimal
expansion which repeats eventually into a rational
number.
Use rational approximations of irrational numbers
to compare the size of irrational numbers, locate
them approximately on a number line diagram,
and estimate the value of expressions (e.g.,
œÄ¬≤).

MAFS.8.NS.1.1

MAFS.8.NS.1.1

MAFS.8.NS.1.2

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Real Numbers > Convert between Decimals and Fractions > Discover >
Investigate > Investigation 1: Shape Shifting Part 1: Fractions to Decimals >
Hands-on Activity: Using a Spreadsheet
https://app.discoveryeducation.com/learn/player/cddb792c-eb83-4c08b9b3-fdd3688df27c
Real Numbers > Convert between Decimals and Fractions > Discover >
Investigate > Investigation 2: Shape Shifting Part 2: Decimals to Fractions
https://app.discoveryeducation.com/learn/techbook/units/af0b44c4-f7f748ae-b9bb-241f35de095e/concepts/2939c6b8-238d-416a-86a43741c61b01ab/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/412d62d1-81ec-4626-9af3-f13bdb0f5b9b
Real Numbers > Compare Rational and Irrational Numbers > Discover >
Investigate > Investigation 1: Which One is Not Like the Others?
https://app.discoveryeducation.com/learn/techbook/units/af0b44c4-f7f748ae-b9bb-241f35de095e/concepts/615209e6-3972-4826-837c923ee2eaf27b/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/2be6e827-00fa-42c7-867b-092b960a93e8
Real Numbers > Compare Rational and Irrational Numbers > Discover >
Investigate > Investigation 3: Zooming In
https://app.discoveryeducation.com/learn/techbook/units/af0b44c4-f7f748ae-b9bb-241f35de095e/concepts/615209e6-3972-4826-837c923ee2eaf27b/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/c2d62833-0cd2-4f2a-8ca6-1763d760c2e7

BENCHMARK CODE

BENCHMARK

MAFS.8.NS.1.2

Use rational approximations of irrational numbers
to compare the size of irrational numbers, locate
them approximately on a number line diagram,
and estimate the value of expressions (e.g.,
œÄ¬≤).

MAFS.8.NS.1.2

MAFS.8.SP.1.1

MAFS.8.SP.1.1

Use rational approximations of irrational numbers
to compare the size of irrational numbers, locate
them approximately on a number line diagram,
and estimate the value of expressions (e.g.,
œÄ¬≤).
Construct and interpret scatter plots for bivariate
measurement data to investigate patterns of
association between two quantities. Describe
patterns such as clustering, outliers, positive or
negative association, linear association, and
nonlinear association.
Construct and interpret scatter plots for bivariate
measurement data to investigate patterns of
association between two quantities. Describe
patterns such as clustering, outliers, positive or
negative association, linear association, and
nonlinear association.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Real Numbers > Compare Rational and Irrational Numbers > Discover >
Investigate > Investigation 2: Squaring Up > Interactive: Tiling a Shower
https://app.discoveryeducation.com/learn/techbook/units/af0b44c4-f7f748ae-b9bb-241f35de095e/concepts/615209e6-3972-4826-837c923ee2eaf27b/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/d275430b-6e01-43d5-91b2-fc49e5b1cb75
Real Numbers > Compare Rational and Irrational Numbers > Discover >
Investigate > Investigation 3: Zooming In > Hands-On Activity: Sliding
Number Lines
https://app.discoveryeducation.com/learn/player/2cfef748-3b1b-42bf8bb1-187bb4993010
Bivariate Data > Create and Analyze Scatter Plots > Discover > Investigate >
Investigation 2: Scattered > Which are Outliers?
https://app.discoveryeducation.com/learn/techbook/units/72257bd7-7c554a5c-b2ff-8cd16600d5be/concepts/db36f7dd-762b-4c67-8d05973ceadf30eb/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/9dd2081a-8d2c-425e-9b7f-83f390acbbf7
Bivariate Data > Create and Analyze Scatter Plots > Discover > Investigate >
Investigation 2: Scattered > Data Associations
https://app.discoveryeducation.com/learn/techbook/units/72257bd7-7c554a5c-b2ff-8cd16600d5be/concepts/db36f7dd-762b-4c67-8d05973ceadf30eb/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/9dd2081a-8d2c-425e-9b7f-83f390acbbf7

BENCHMARK CODE

BENCHMARK

MAFS.8.SP.1.1

Construct and interpret scatter plots for bivariate
measurement data to investigate patterns of
association between two quantities. Describe
patterns such as clustering, outliers, positive or
negative association, linear association, and
nonlinear association.

MAFS.8.SP.1.2

MAFS.8.SP.1.2

MAFS.8.SP.1.2

Know that straight lines are widely used to model
relationships between two quantitative variables.
For scatter plots that suggest a linear association,
informally fit a straight line, and informally assess
the model fit by judging the closeness of the data
points to the line.
Know that straight lines are widely used to model
relationships between two quantitative variables.
For scatter plots that suggest a linear association,
informally fit a straight line, and informally assess
the model fit by judging the closeness of the data
points to the line.
Know that straight lines are widely used to model
relationships between two quantitative variables.
For scatter plots that suggest a linear association,
informally fit a straight line, and informally assess
the model fit by judging the closeness of the data
points to the line.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Bivariate Data > Create and Analyze Scatter Plots > Discover > Investigate >
Investigation 1: Scatter Plots Revealed
https://app.discoveryeducation.com/learn/techbook/units/72257bd7-7c554a5c-b2ff-8cd16600d5be/concepts/db36f7dd-762b-4c67-8d05973ceadf30eb/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/73f62ac8-5df2-41bd-bab6-318bbbe69cb6
Bivariate Data > Generate Lines of Best Fit > Discover > Investigate >
Investigation 2: Which Fits Best? > Hands- On Activity: Which Fits Best
https://app.discoveryeducation.com/learn/player/4ad1abbc-8e6c-4a3ba211-358f522b8378
Bivariate Data > Generate Lines of Best Fit > Discover > Investigate >
Investigation 3: Go to the Line > Hands- On Activity: Go to the Line
https://app.discoveryeducation.com/learn/player/90a3f1f4-0f7b-4f80-9063caa54ce9f411
Bivariate Data > Create and Analyze Scatter Plots > Discover > Investigate >
Investigation 2: Scattered > Data Associations
https://app.discoveryeducation.com/learn/techbook/units/72257bd7-7c554a5c-b2ff-8cd16600d5be/concepts/db36f7dd-762b-4c67-8d05973ceadf30eb/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/9dd2081a-8d2c-425e-9b7f-83f390acbbf7

BENCHMARK CODE

BENCHMARK

MAFS.8.SP.1.3

Use the equation of a linear model to solve
problems in the context of bivariate measurement
data, interpreting the slope and intercept.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Bivariate Data > Generate Lines of Best Fit > Apply > Apply 1: What
Relationships Exist Between Calories, Fat, Cholesterol, Salt, and Other
Nutrients?

Use the equation of a linear model to solve
problems in the context of bivariate measurement
data, interpreting the slope and intercept.

https://app.discoveryeducation.com/learn/techbook/units/72257bd7-7c554a5c-b2ff-8cd16600d5be/concepts/25d243e0-b7e1-455b-884d6110d359b00e/tabs/6dc41756-43ff-4f63-bd113148dd938983/pages/8f2caf1b-14ad-4f47-b7f4-f3bef16052dc
Bivariate Data > Generate Lines of Best Fit > Discover > Investigate >
Investigation 4: Predictions About the Wave > Write an Equation > Interpret
the Slope and y-intercept

MAFS.8.SP.1.3

MAFS.8.SP.1.3

MAFS.8.SP.1.4

Use the equation of a linear model to solve
problems in the context of bivariate measurement
data, interpreting the slope and intercept.

Understand that patterns of association can also
be seen in bivariate categorical data by displaying
frequencies and relative frequencies in a two-way
table. Construct and interpret a two-way table
summarizing data on two categorical variables
collected from the same subjects. Use relative
frequencies calculated for rows or columns to
describe possible association between the two
variables.

https://app.discoveryeducation.com/learn/techbook/units/72257bd7-7c554a5c-b2ff-8cd16600d5be/concepts/25d243e0-b7e1-455b-884d6110d359b00e/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/1c9d1dd0-c316-4e72-a337-ca29e39e8785
Bivariate Data > Create and Analyze Scatter Plots > Discover > Investigate >
Investigation 3: Analyzing Scatter Plots > Make a Conjecture
https://app.discoveryeducation.com/learn/techbook/units/72257bd7-7c554a5c-b2ff-8cd16600d5be/concepts/db36f7dd-762b-4c67-8d05973ceadf30eb/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/1670a120-382d-46d6-8a02-e945833ecad9
Bivariate Data > Create and Analyze Two-Way Tables > Apply > Apply 1: Are
the Books and Movies That People Like Related?
https://app.discoveryeducation.com/learn/techbook/units/72257bd7-7c554a5c-b2ff-8cd16600d5be/concepts/c59fdefa-441a-4efb-994908af3d9c483a/tabs/6dc41756-43ff-4f63-bd113148dd938983/pages/2881f053-b1cf-4f6e-b8e1-0bef929865bf

BENCHMARK CODE

BENCHMARK

MAFS.8.SP.1.4

Understand that patterns of association can also
be seen in bivariate categorical data by displaying
frequencies and relative frequencies in a two-way
table. Construct and interpret a two-way table
summarizing data on two categorical variables
collected from the same subjects. Use relative
frequencies calculated for rows or columns to
describe possible association between the two
variables.
Understand that patterns of association can also
be seen in bivariate categorical data by displaying
frequencies and relative frequencies in a two-way
table. Construct and interpret a two-way table
summarizing data on two categorical variables
collected from the same subjects. Use relative
frequencies calculated for rows or columns to
describe possible association between the two
variables.
Make sense of problems and persevere in solving
them.

MAFS.8.SP.1.4

MAFS.K12.MP.1.1

MAFS.K12.MP.1.1

Make sense of problems and persevere in solving
them.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Bivariate Data > Create and Analyze Two-Way Tables > Discover > Investigate
> Investigation 1: Let's Table It!
https://app.discoveryeducation.com/learn/techbook/units/72257bd7-7c554a5c-b2ff-8cd16600d5be/concepts/c59fdefa-441a-4efb-994908af3d9c483a/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/1a32d67a-5eaf-4a34-8c3d-195fc584f4b4
Bivariate Data > Create and Analyze Scatter Plots > Discover > Investigate >
Investigation 1: Scatter Plots Revealed > Gather Data
https://app.discoveryeducation.com/learn/techbook/units/72257bd7-7c554a5c-b2ff-8cd16600d5be/concepts/db36f7dd-762b-4c67-8d05973ceadf30eb/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/73f62ac8-5df2-41bd-bab6-318bbbe69cb6
Real Numbers > Investigate Square Roots and Cube Roots > Discover >
Investigate > Investigation 3: Pinpoint those Numbers > Plot Square Roots,
Plot Cube Roots
https://app.discoveryeducation.com/learn/techbook/units/af0b44c4-f7f748ae-b9bb-241f35de095e/concepts/70aa0bcb-6c87-46e7-acbb2919cb514e76/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/866384b6-839d-4041-9850-79b3d750aad7
Volume of Solid Figures > Investigate Volume Formulas > Discover >
Investigate > Investigation 3: Volume of a Sphere
https://app.discoveryeducation.com/learn/techbook/units/9b962216-ccf74e86-813b-90d8042fff94/concepts/c7f089f3-4afe-44cc-9230b43aac565ab7/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/3b77469f-6dbe-45bb-afbd-c3e318533cf9

BENCHMARK CODE

BENCHMARK

MAFS.K12.MP.1.1

Make sense of problems and persevere in solving
them.

MAFS.K12.MP.2.1

MAFS.K12.MP.2.1

MAFS.K12.MP.2.1

Reason abstractly and quantitatively.

Reason abstractly and quantitatively.

Reason abstractly and quantitatively.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Exponents > Understand Rules of Exponents > Discover > Investigate >
Investigation 1: Exponent Cards > Equivalent Expressions 1 and 2
https://app.discoveryeducation.com/learn/techbook/units/014e6947-c24b4c5d-bd55-60139d53bdb0/concepts/1031e796-a180-404b-80bab81e4ed0778a/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/bafbbfe1-730c-487e-8968-85c9be284f9a
Linear Systems > Model Situations with Multiple Equations > Discover >
Investigate > Investigation 3: Mixture Mysteries > Tales from the Tables
https://app.discoveryeducation.com/learn/techbook/units/27a72144-87814826-9df8-1f2a1a469105/concepts/d701728c-7ce7-4640-a1a922d8ed8253ef/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/cc8210bb-9a3c-4b41-b053-a4bc5ad18a40
Introduction to Functions > Represent Proportional Relationships > Discover
> Investigate > Investigation 1:Getting to School
https://app.discoveryeducation.com/learn/techbook/units/a96818f5-c22649ec-bc78-a0594707de88/concepts/bcea2e30-74a4-4500-84bc6d4470261b4a/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/4b030e18-6ebd-4c2d-bf06-4c9553985bb8
Bivariate Data > Create and Analyze Two-Way Tables > Apply > Apply 1: Are
the Books and Movies That People Like Related?
https://app.discoveryeducation.com/learn/techbook/units/72257bd7-7c554a5c-b2ff-8cd16600d5be/concepts/c59fdefa-441a-4efb-994908af3d9c483a/tabs/6dc41756-43ff-4f63-bd113148dd938983/pages/2881f053-b1cf-4f6e-b8e1-0bef929865bf

BENCHMARK CODE

BENCHMARK

MAFS.K12.MP.3.1

Construct viable arguments and critique the
reasoning of others.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Introduction to Functions > Represent Proportional Relationships > Discover
> Investigate > Investigation 1:Getting to School

Construct viable arguments and critique the
reasoning of others.

https://app.discoveryeducation.com/learn/techbook/units/a96818f5-c22649ec-bc78-a0594707de88/concepts/bcea2e30-74a4-4500-84bc6d4470261b4a/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/4b030e18-6ebd-4c2d-bf06-4c9553985bb8
Bivariate Data > Create and Analyze Scatter Plots > Discover > Investigate >
Investigation 1: Scatter Plots Revealed > Draw a Conclusion

Construct viable arguments and critique the
reasoning of others.

https://app.discoveryeducation.com/learn/techbook/units/72257bd7-7c554a5c-b2ff-8cd16600d5be/concepts/db36f7dd-762b-4c67-8d05973ceadf30eb/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/73f62ac8-5df2-41bd-bab6-318bbbe69cb6
Bivariate Data > Create and Analyze Scatter Plots > Discover > Investigate >
Investigation 3: Analyzing Scatter Plots > Make a Conjecture

MAFS.K12.MP.3.1

MAFS.K12.MP.3.1

MAFS.K12.MP.4.1

Model with mathematics.

https://app.discoveryeducation.com/learn/techbook/units/72257bd7-7c554a5c-b2ff-8cd16600d5be/concepts/db36f7dd-762b-4c67-8d05973ceadf30eb/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/1670a120-382d-46d6-8a02-e945833ecad9
Real Numbers > Compare Rational and Irrational Numbers > Discover >
Investigate > Investigation 3: Zooming In
https://app.discoveryeducation.com/learn/techbook/units/af0b44c4-f7f748ae-b9bb-241f35de095e/concepts/615209e6-3972-4826-837c923ee2eaf27b/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/c2d62833-0cd2-4f2a-8ca6-1763d760c2e7

BENCHMARK CODE

BENCHMARK

MAFS.K12.MP.4.1

Model with mathematics.

MAFS.K12.MP.4.1

MAFS.K12.MP.5.1

MAFS.K12.MP.5.1

Model with mathematics.

Use appropriate tools strategically.

Use appropriate tools strategically.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Intersecting Lines and Angles > Investigate Parallel and Intersecting Lines >
Discover > Investigate > Investigation 3: Lines, Angles, and Triangles > HandsOn Activity: Chees Sandwiches
https://app.discoveryeducation.com/learn/player/f047e603-eb7d-49939ba0-cd4851d2b952
The Pythagorean Theorem > Investigate the Pythagorean Theorem >
Discover > Investigate > Investigation 2: Conduct an Experiment >
Interactive: Squares on a Triangle
https://app.discoveryeducation.com/learn/techbook/units/26800a8c-8a694adf-8fee-a22e9326c226/concepts/c93bbe5b-6081-487a-942b13c141581da6/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/b191e128-3614-4ff7-b055-dcdefdbd71bd
Real Numbers > Investigate Square Roots and Cube Roots > Discover >
Investigate > Investigation 1: Something Radical < use of Calculator
https://app.discoveryeducation.com/learn/techbook/units/af0b44c4-f7f748ae-b9bb-241f35de095e/concepts/70aa0bcb-6c87-46e7-acbb2919cb514e76/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/e2c691be-332d-41f5-a68f-4c0a0af4d14b
Real Numbers > Investigate Square Roots and Cube Roots > Discover >
Investigate > Investigation 3: Pinpoint those Numbers > use of calculator
https://app.discoveryeducation.com/learn/techbook/units/af0b44c4-f7f748ae-b9bb-241f35de095e/concepts/70aa0bcb-6c87-46e7-acbb2919cb514e76/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/866384b6-839d-4041-9850-79b3d750aad7

BENCHMARK CODE

BENCHMARK

MAFS.K12.MP.5.1

Use appropriate tools strategically.

MAFS.K12.MP.6.1

MAFS.K12.MP.6.1

MAFS.K12.MP.6.1

Attend to precision.

Attend to precision.

Attend to precision.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Intersecting Lines and Angles > Investigate Parallel and Intersecting Lines >
Discover > Investigate > Investigation 1: Transversals and Parallel Lines >
Hands-On Activity: Patty Paper
https://app.discoveryeducation.com/learn/player/767da0fa-fb68-41e38d23-5bd34e2d5343
Introduction to Functions > Represent Proportional Relationships > Discover
> Investigate > Investigation 2: Similar Triangles and Slope
https://app.discoveryeducation.com/learn/techbook/units/a96818f5-c22649ec-bc78-a0594707de88/concepts/bcea2e30-74a4-4500-84bc6d4470261b4a/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/3d591f76-a989-4fcb-b3af-e959411dc3fa
Introduction to Functions > Represent Proportional Relationships > Discover
> Investigate > Investigation 3: Rate of Change and Slope
https://app.discoveryeducation.com/learn/techbook/units/a96818f5-c22649ec-bc78-a0594707de88/concepts/bcea2e30-74a4-4500-84bc6d4470261b4a/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/2485c9d5-4ca4-4b5d-a812-58d1cf3635e4
Real Numbers > Investigate Square Roots and Cube Roots > Discover >
Investigate > Investigation 3: Pinpoint those Numbers
https://app.discoveryeducation.com/learn/techbook/units/af0b44c4-f7f748ae-b9bb-241f35de095e/concepts/70aa0bcb-6c87-46e7-acbb2919cb514e76/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/866384b6-839d-4041-9850-79b3d750aad7

BENCHMARK CODE

BENCHMARK

MAFS.K12.MP.7.1

Look for and make use of structure.

MAFS.K12.MP.7.1

MAFS.K12.MP.7.1

MAFS.K12.MP.8.1

Look for and make use of structure.

Look for and make use of structure.

Look for and express regularity in repeated
reasoning.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Real Numbers > Investigate Square Roots and Cube Roots > Discover >
Investigate > Investigation 1: Something Radical
https://app.discoveryeducation.com/learn/techbook/units/af0b44c4-f7f748ae-b9bb-241f35de095e/concepts/70aa0bcb-6c87-46e7-acbb2919cb514e76/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/e2c691be-332d-41f5-a68f-4c0a0af4d14b
Scientific Notation > Represent Large and Small Numbers > Discover >
Investigate > Investigation 1: Compact It! > noted when students share how
the scientific notation is related to the standard form
https://app.discoveryeducation.com/learn/techbook/units/2e07479f-63e54f2b-a4a1-fc18d4f27875/concepts/8b97a8e7-079d-4b74-8eedbc9e3e0d5394/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/548fdc38-cd7f-4fc3-90b1-b2d5ec1ecb0e
Bivariate Data > Create and Analyze Scatter Plots > Discover > Investigate >
Investigation 3: Analyzing Scatter Plots > Make a Conjecture
https://app.discoveryeducation.com/learn/techbook/units/72257bd7-7c554a5c-b2ff-8cd16600d5be/concepts/db36f7dd-762b-4c67-8d05973ceadf30eb/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/1670a120-382d-46d6-8a02-e945833ecad9
Real Numbers > Investigate Square Roots and Cube Roots > Discover >
Investigate > Investigation 1: Something Radical
https://app.discoveryeducation.com/learn/techbook/units/af0b44c4-f7f748ae-b9bb-241f35de095e/concepts/70aa0bcb-6c87-46e7-acbb2919cb514e76/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/e2c691be-332d-41f5-a68f-4c0a0af4d14b

BENCHMARK CODE

BENCHMARK

MAFS.K12.MP.8.1

Look for and express regularity in repeated
reasoning.

MAFS.K12.MP.8.1

Look for and express regularity in repeated
reasoning.

LESSONS WHERE STANDARD/BENCHMARK IS DIRECTLY ADDRESSED IN
MAJOR TOOL (MOST IN-DEPTH COVERAGE LISTED FIRST)
(Include the student edition and teacher edition with the page numbers of
lesson, a link to lesson, or other identifier for easy lookup by reviewers.)
Exponents > Understand Negative Exponents > Discover > Investigate >
Investigation 1: Zero Power > see first Teacher Note
https://app.discoveryeducation.com/learn/techbook/units/014e6947-c24b4c5d-bd55-60139d53bdb0/concepts/96477290-647b-4efa-bf23890097cb5cf2/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/78cffff1-5fbb-431c-9a7d-8cf4e66c2f01
Real Numbers > Convert between Decimals and Fractions > Discover >
Investigate > Investigation 3: Shape Shifting Part 3: Identify the Criminal >
see first Teacher Note
https://app.discoveryeducation.com/learn/techbook/units/af0b44c4-f7f748ae-b9bb-241f35de095e/concepts/2939c6b8-238d-416a-86a43741c61b01ab/tabs/19155618-5d23-4aa5-a4e5017f733dab9a/pages/87953cc6-994a-4d72-a09a-ffb4fb778dbc

